
Fax modem 
Before your PC can recognise the communicator as a fax modem, the PC needs to be 
properly configured. Consu lt the user's guide of your PC on how to install new 
modems. PCs with Microsoft Windows 95 or NT 3.51 or higher operating systems 
can use the modem information file found on the diskette supplied in the 
communicator sales package. See also the Documentation section on the CD-ROM. 

Using the communicator as a fax modem requ ires that data ca lls are 
supported by the network you are using and that this service is activated for 
your SIM card. Contact your home service provider for details. 

Fax modem --Activ~te j O 
I 

0 
0 

Infrared Close · 0 
~==============================d---·----·~ 

Figure 3 

1 Press Settings and select the connection type. The functioning ofa cable 
connection when the communicator is used as a fax modem is not 
guaranteed. 

2 Connect the com mu.nicator to the PC via an infrared link as described in 
"To use the PC Suite" on page 39. 

3 Wait until the connection is established. 

4 Press Act ivate in the Fax modem main view. This will change the 
communicator to a fax modem. When the communicator is used as a fax 
modem, the call status indicator shows the text MODEM. 

5 To stop using the commun icator as a fax modem, press Disable. 

The operations of a modem can be controlled by AT commands and S­
registers. Thes·e commands give the advanced user an opportunity to control 
all the features of the modem. Should you need to enter the commands 
manually, consult the documentation of the PC application that you are using. · 
A list of common AT commands based on the ETSI 07.07 standard and 
supported by the Nokia 9110 Communicator are available in the atcomm.txt 
file on the diskette inclu.ded in the sales package of your communicator. 

When the communicator is used as a fax modem, its normal communication 
features are disabled. Otherwise, the app lications remain functional. 

If an active PC connection is idle for longer than 20 minutes, the fax modem is 
automatically disab led to conserve power. However, when .. the communicator 
is connected to an electrical outlet, for example, while charging a battery, the 
time-out is not active. 
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Data removal 
The Data removal application comes in handy if you want to remove personal 
information from th~ communicator, for example, before lending it to 
someone else. In this way you need not remove data one by one. 
1 Select what kind of data you want to remove. The removable data is 

arranged in four groups: All device data, Calendar data, Documents, 
Contacts and speed dials. 

2 Press Delet e. 

3 s·efore any d'ata is removed, you must enter your lock code. See "Security" 
on page 127. When removing calendar data, you can choose to remove all 
calendar data or only events that occur before a given date. 

"il ~=~==:,-;::=-·"'1'' 
:;.option, your Internet settings will not be removed . I 

'If you want to r.estore your communicator to the ~ J 

.same state it was in at the time of purchase, see 
chapter 15 "Troubleshooting" on page 165. . 
111£11111~il.tB!!Iiijj'ifmi.'IJ~l>.f.~~ll\ltlll'l.#l~lll!ll:l!~:ll;'~'**~·..;~.,_,, .. 

Install/Remove software 
The Install/Remove software application enables you to install new software 
from a PC to the communica,tor and later remove the software. · 

·:· !mmsr.;!M#I*!til~~lll~~~!llt~~~tj!ffll-~~....,un 

Caution: Beware of viruses! Only install on 
the Nokia 91 10 Communi·cator software 
you have obtained from sources that offer .:. 
adequate prQtection against viruses. . . 

·.~ ':Jmlij:t.imtit"HWimt.f.l:t.lml~1:~wmm:~=~tt~:mml:~mt~ttmi'l nmnm~~:~:mn;:ll:tiJ'~:."'1'<" ..... :;:. .. ~ · 

To use this application, you need to start the Nokia Communicator Server on 
your PC and connect your communicator to the PC. See "To use the Nokia 
Communicator Server" on page 46. 

Press Install and select the software you want to install, or press Remove and 
select the software you want to remove. 

The set of applications that were on the communicator at the time of 
purchase cannot be removed. This is to ensure that the. basic functions of the 
communicator are always available. 

-II5;~:~~i~i~i~~i~~~~~:irJ . 
....a-+~~~~:tm.a:a.-:rw..: .. ,.~ .. .. 
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Backup/Restore 
The Backup/Restore application enables you to make backups of various data 
on your communicator, and to restore it later. Data is backed up in sets which 
are stored in separate directories on the PC; 

To use this application, you need to start the Nokia Communicator Server on 
your PC and connect your communicator to the PC. See "To use the Nokia 
Communicator Server" on page 46. 

Select whether to backup All data, Documents, Contacts, or Calendar and 
press Backup. A backup directory will be created if necessary. 

The restoration procedure is carried out in the same way as the backup operation, 
except that instead of Backup you must pres? Restore. When data is restored, 
files with similar names in the destination folder will be overwritten. 

j· 
'•l' ~.#l~~~#ll#r:;lUitl'!1il:~:<:Jt- , .. 

Note: While the Backup/Restore is in progress, ~; . 
the other applications of the communicator 
cannot be used. To interrupt the operation, for 
example, to make an emergency call, press 11 
Cancel and confirm by pressing Interrupt. ~ 

·" · ··JJ:atiit;llti~Jil!lli~U:Iitl:Hai~~!=IWtFI:~~ll:<!.ltl·<.:.:._ ., .•.. ,. 

To make backups or restore data between a Nokia 9000 Commun icator or a 
Nokia 9000i Communicator and a Nokia 9110 Communicator, see "To transfer 
data from older communicator models" on page 37. 

r.~~~fb~ii~:~~~~i~~:·;-]. • 
. E:;.:~~~~~~ .x.:, 

.Memory card tool 
The Memory card tool applic;ation can only be started if there is a memory 
card inserted in the communicator. 

With this application, you can format and rename the memory card, and 
· check the condition of the files. 

About this ·product 
This applic~tion displays information about th·e Nokia 9110 Communicator. 
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Press the f$3 button on the keyboard to open the Extras application group, 
which contains Calculator, Clock, Composer and Voice recorder. With Extras 
you can also launch applications located on your memory card. 

i~7:~M~~~~~;:·~~;;t=t·· 
· ~mstalled to your tornmun1cator I! 
( rom the CD-ROM included in the ~ 

:£:~,~~~;.~~~~~'".1 ... , 
To start one of the applications, ·select it and press Select. 

To close an active application, press Close. 

'1!~7~~~~::~~;k~~~f£~o£ -~·· 
l another by pressing the f$3 ~ 
! button. 'it 
~~~:Jttltli:!fttJ~[l'd::!i~H;~j-11:""'"•=:~-.. 

Calculator 

~~~w==r===========================;~liFtFu~~tions j 

1m------~---- __ l l 
Figure 1 

I 
' 

Copy~~ 
I 

Clear list l 

Clo~ 

0 
0 
0 
0 

The Calculator contains an input field at the bottom of the screen, and above 
it a list where previous calculations, if any, can be seen. The most recent 
calculations are shown at the bottom of the list. · 

The list can be scrol led with the arrow keys, and it can be emptied by pressing 
Clear list. 

The resu lts of the calcu lations appear in bold. As long as you have not pressed 
Enter or"=", you can move in the calculation string with the arrow keys and 
edit the string. 
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~ The following characters can be used for the corresponding operations: 
+J 
)( 

w 

Numbers 0 to 9 

. (full stop) decimal point 

+ addition 

subtraction 

* multiplication 

I division· 

( ) brackets 

= or Enter sum 

Esc clears the entry field 

To add functions in the input field 
1 Press Functions. 

2 Sel~ct one of the available categories and press Select. You will see a list 
of functions and you can select the one you want. You can select severa l 
functions before returning to the Calculator main view. 

To copy calculations in the input field 
1 Press Copy to select and copy a calculation or a result back to the input 

field for modification or recalculation. 

2 To copy a calculation, press Copy calculation, and to copy a result, press 
Copy resu It 

3 Press Back. The ?elected item will be copied to the input field. 

To change the mode of the calculator 

When you press the Menu button in the Calculator main view and select 
Settings, you can change the mode of the calculator. Select either Radians, 
Degrees, or Gradients, and press OK. 

Clock 
The Clock shows the time and date in your home city and country, as well as in 
several other cities and countries in the world. The Clock also includes an 
alarm clock. 
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To set an alarm 

Home city and 
home country 

'*~ Helsinki 
finland _ __. 

Date 

Figure 2 

of alarm 

An alarm can be set to occur within the next 24 hours. Alarms that occur later 
than this are set in the Calendar applicatio-n. 
1 Press Alarm clock in the Clock main view: 

2 Press + or- to adjust the time shown in the alarm clock display. Each press 
changes the time by one minute, but if you hold the button down a while 
longer, the time will start to change in15-minute steps. 

3 Press OK to accept the set alarm. When an alarm is set, the bell icon and 
the time of the alarm are shown in the Clock main view. 

There can only be one active alarm. If an alarm is already active, the command 
names are different. A co.unter on the lower right side of the screen shows 
how much time remains to the time of the alarm. 

Press Change alarm time if you want to readjust the time of the alarm. 

Press Delete alarm to cancel the alarm. 
<!.J.-rrn~!mmrt;t>·~~" ~r··~•r'!l~l ~~m ~:--~~~~~! "!~ ·-- • • 'ti 
I Note: Alarms will occur according 1·~ ~ to the home city time. When in a 1 1 different time zone, remember to f.! 

1 change the home city. ~l 
~~1111' fi'l 1 11111±1Jlhili!t!l:ffj!!HFftd'<DH!l~-,...., ~ -·· 

To turn off the alarm sound 
1 When the alarm sounds, press any phone or communicator keyboard key to 

silence it. 

2 Press the OK command button. If you do not .press OK, the alarm will 
sound four more times or until you press the OK button. However, if the 
alarm interval is set to zero, the alarm will sound only once. Set the alarm 
interval in the clock settings. 
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World· time 

World time (figure 3) is accessed with the W orld time command in the Clock 
main view. 

The Home box shows the name of the currently selected home city, country, 
time, date and whether daylight saving time is in use. 

The Destination box shows the same information for the currently selected 
destination city, as well as the international call prefixes needed to make a 
call from the home city to the destination city. 

The world map shows the currently selected destination city in tross hairs. 

Home 
Helsinki, Finland 
0 20:43 4< 
!:!!14.06.98 

destination 

Destination 
San Francisco, USA 
0 09:43 
!:!!14.06.98 
'it +1 21 

To select the destination city 
1 Press Set destinat ion. 

Cities! 

Close! 

Figure 3 

2 Select a city from the list by scrolling the list with the arrow keys. 

3 Press OK. 

Tip: A quick way to select a city from the list 
·~.of cities is to type the first letter of the city · 
·~with the keyboard. The selection frame · 

· ~umps to the first city starting with that 
· letter. 
'\!~t!i#i;mmt;j;'§tt;;i~-~~Jf.lll!~tlltllttllllll!!~:'\'~ 

To edit and add cities 
1 Press Cities in the world time view to open a list of cities. 

0 
0 
0 
0 

2 To make changes to existing cities, press Edit city. The city information is 
presented in the form of a card with the following fields: 

City- The name shown in the list of cities. Can be entered manually. 

Country- The name of the country associated with the city. The country 
name is selected from the Jist of countries. 

Area code ·- The area code required when calling the city. The area code 
can be entered with or without a national prefix. Only numbers can be 
entered. 
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GMT offset- Indicates by how much .the local time ·differs from the 
Greenwich Mean Time .. Select a value for the offset from a list. The offset 
can range from - 12 to+ 12 hours. 

Set position - Opens a world map view where you can determine the 
position of the city by moving the cross ha irs with the arrow keys. When 
the city is where you want it to appear, press OK. 

To create a new city card, press Add ci ty. 

To remove a city from the list, press Delete city. The current home city cannot 
be removed; you will have to change the home city first. 

To change the Clock settings 
1 Press Settings in the Clock main view. 

· 2 Select the setting you want.to .change and press .Cha nge, or type the new 
time or.date from the keyboard. · · · 

Home city- Select the home city by scrolling the list of cities with the 
arrow keys. When your home city has been selected, press OK. If you sel~ct 
a city that is in a different time zone than your .current home city, the. 
system. time will change. 

Time- Enter the new time. The time format is selected in the System 
settings . 

. Date- Enter the new date. The date format is ·selected in the System 
settings. · 

Alarm interval: 0/1/2/3/4/5 minutes- Choose the interval between alarms . . 
If you select 0, the alarm will go off only once. 

Daylight saving- You can set the daylight saving time of the home city 
and des.tiriation city On or' Off. This setting remains the same even if the 
home/destination city is changed. · 

~*~'·"';ll!J'f:F-b.<J~N!ftttlw -~~t<Zttl1jt:l!l~"'IJL.,.'!P.'''~·g:;.o.:;;·~·· · "'1.: ••. 

I.Note~Changi.ng the tim~ or dayli~·ht ~;~i;g - -. Jtl~ 
l ime of the .home city will also adjust the ti~e of ~;! 

lthe whole t1me zone, as w_ell as the system.t1me. !ii 
!! a set alarm is sk_ipped be~ause ~fa changed f[~ 

! I me, the alarm w1ll go off 1mmed1ately. ··~ 
. j." 

- i1mt!'i~!:imt.il:ttii~6','J:~i ;:;ji~I*.~Woi:j:f.<~ti~1#!!l.~t!tft~:!fftl:~!tilt!!t.Jt.••~·+-· "'-'-' 

Composer 
The Composer application enables you to create your own, customised ringing 
tones. 

To start the composer for the selected tune; press Open. 

To compose a new tune press Compose. 
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§ To play the selected tune, press Play. While the tune is being played, the 
;E command changes into Stop playing. · 

.... ;~ ........................ ,....,... ............. ~ ......... ,.. .. ,, ....... , ......... , .... """' . ....,;.....' ~-~<=<=·~··~· . .....,.,~~- ______ ;,.... .. 
-,~~[l:Uilia:ttll.'m:l:r.am;::!'ttb:t!:;:u:m:m:tr.!:::Dn1 : . .'t1Ig:t':IJ%i:o2"1l::Q".aszt'1::t:.fl'i."'~~ "H'H'-~ •• • .~·. §~ -

. :!~ ~ote: You .can ch~nge the phone ringing tone U[ 
t 1n the Profile settmgs of the Telephone ,!jri 
~ application or in the System sounds setting of ·1~ · 

,~ the System appli.cation. See "Telephone lg 
~=m settings" on page 65 and "System settings" on at 
~~ ~. 
~JJ page 125. !! 
.;Ja!'ftm~=~~R¥{·~~~=~=-4.-"., ..... 

To edit a tune 
1 Open a tune or press Compose. A cursor appears at the bottom of the 

screen, ind icating the currently selected note or rest. 

2 To create a note or to alter the pitch of the note, press the up or down 
arrow keys. Each press changes the pitch -of the no.te. A rest will appear 
after all possible note levels have been scrolled th_rough. 

3 To move the cursor, press th.e left or right arrow keys. 
7.,~· -~t!$:ll=~~,-lltC~$11r:&lmi:~;Jte:~·,,Jli;J;j~"J' ";;•· .,,.· ~·-· .. 

; Note: To edit the preset tunes that I 
\!Were in the communicator at the H 
ijtime of purchase, press the Menu ;,1 
l button and select Copy. ~] 
·~'f.~.lll;l!ii:ilfW~~"''fi''I'~I':~~~~R:I-J~~-r:-~~x· ,_, ..... 

;==== ===============:::;1 -··------· ...... ... .. 
Duration: 

Tempo: 

Play! 

Close! 

Figure 4 

0 
0 
0 
0 

When a composition is being made, the following commands are available: 

Duration changes the length of the ·selected note. Choose a quarter note, half 
note, whole note, sixteenth note, or eighth note. Press the command button 
until the value you want is shown. 

Tempo opens a pop-up box with a new set of commands. Tempo is measured 
in beats per minute. To alter the te_mpo, remove the old value with the 
backspace key and enter the new value in the input field. 

To accept the tempo, press OK. 
To test the tempo, press Test. The tune will be played with the tempo 
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shown in the entry field. 
To use the default tempo 160 beats/min., press Default. 

Play plays the composition shown on the staff. 

To remove a composition, press the Menu button, and select Delete. 
To restore the tune to what it was before editing, press the Menu button and 
select Undo changes. · · 
Close returns to the Composer main- view. 

To use shortcuts 
While editing, you can use the following shortcuts: 

Enter 

:(colon) 

- (hyphen) 

Space bar 

Backspace 

. (full stop) 

Plays the tune 

Staccato 

Inserts a rest 

Inserts an empty column to the left of the cursor. 

Deletes the selected column containing a note or a 
rest. 

Lengthens the duration of the note or rest by half 

'l~r:l~~::~~~~~:;~:~;l=~h:=lj~~v·' ~ 
'corresponding letter key on the keyboa·rd to ·· 
generate a note. For example, pressing D 

I generates the note D. When you press Shift 
J and .a l ~tter key, a sharp note is generated, i 
~ e.g. Sh 1ft-O generates 0 sharp. ~ 
~!!lf.fmtif;;mtitfriilafta'IUI!Bi!'t!tfllljlll~ll!!l!JP.!18lliltLl:.':lltl:jL!!t:>-;,i!· ,.,. 

To use the Menu button 
When you press the Menu button in the Composer main view, the following 
options become available: · 

Copy~ Copies the selected tune. 

Delete- Removes the selected tune(s). 

Rename- You can write the new name into the input field. 

Send as SMS- Opens up the SMS directory wh·ere you can select a recipient 
for the composition(s). To send the composition(s), press Send. 
When you receive a composition via SMS, a note showing the name or number 
of the sender and the name of the sent composition will appear on the display. 
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~ To add the composition to the list of tunes, press Accept. To discard the 
S composition, press Cancel. 

Transfer via IR - Enables you to send tunes from one communicator to 
another via the infrared link. The IR port of the receiving device must be 
activated before the operation. See "Infrared activation" on page 131. 

Copy to memory card- Copies the selected tune(s) to the memory card .. 

Copy from memory card- Copies the selected tune(s) from the memory card 
to your communicator. 

Voice recorder 
The Voice recorder allows you to record telephone conversations and voice 
memos. You can also listen to your recordings and other sound f iles. The 
maxim~m length of a recording is 30 seconds. · 

't~~~;1~~~Xi~~;~t·· 
.them as ringing tones. See ~ 

i "Telephone settings" on page 65. ., 

~·~·~,~Mt.t!trffi~i!t~t!rn!tttr.mlt!m~:'lilflt~ 1'~·!N~'ffl~!"' ....................... , 

The ma in view of the Voice recorder shows a list of all the sound fi les currently 
stored in your communicator. To open the selected file, press Open. New file 
creates a new file into which sound can be recorded. Delete allows you to 
remove the selected file. 

Wheri you open a sound file, you will see the length, which is measured in 
seconds, and the size, which is measured in kilobytes, of the file. 

To play a recording 

t:~;~~:~=~~:~~;;;~~~~·r· 

lrecording conversations. Do 11 
not use this feature illegally. ~ 

Zt.a~:::l:ii:ti~~~U;~~d:dtftti.'CU :tl•.t· 

1 Open the file and press Play. 

2 The Pause command temporarily stops the playing of the sound file. To 
start playing again, press Continue. 

3 To stop playing, press Stop. 

To record 
1 Open the file into which you want the sound to be recorded, and press 

Record. If you are r~cording a telephone conversation, you will hear a ton,e 
when the recording starts. 
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2 You can stop the rec-ording for a while by pressing Pause and then start 
again by pressing Continue. 

3 To stop the recording, press St op. 

-~~N~t~ : r~j~;o~~t;;~~ -~ -~~~~h-~,-
. you need to have the phone turned 
· on and within range of network 
~coverage. . 
.isrt·(vnzits!:tt(:tU:ft.• 1'$:lti rfl1J'2"t'\fm'£'!'f'~';rtt~K·-.;.I~ ••, 

To use the Menu button 

When you press the Menu button in the Voice recorder mam v1ew, the 
following commands become available: 

Rename- Renames the selected recording. , 

Copy to memory card - Copies the selected recording to the memory card. 

Copy from memory card- Copies the selected recording from the memory 
card to your communicator. 

·~~PI4l~~~r·l-··~~~ .. -· 

} Note: Sound files that the voice · 

I 
recorder can play have a .WAV · 

- extension and support the following , 
audio format: 8, 11 , 22 or 44khz, · 

L:!!~~::::~~~·;!.~!~;~.r ·· 
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Figure 7 

When operating the phone, keys are pressed one at a time. Two keys are never 
to be pressed simultaneously. The phone keypad is not functional when the 
device cover is open. 

<D -Switches the phone on and off. 

~= - Switches between different profiles. See "Profiles (Menu 3)" on 

y 1\ 

page 158. 

- Scroll through menus, submenus or settings. If there are no 
active calls, the scroll keys can be used to browse through the 
memory contents. When a call is active, pressing the scroll keys 
adjusts the volume level. 

-Dials a phone number and answers a call. 

-Ends any active call, cancels a dialled call, or clears the display. 
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0 ... 9 -The number and alphabet keys. To call your voice mailbox, press 

and hold 1. 

* # - Used for special purposes in certain functions.· If you h_ave 
·subscribed to two phone lines, you can switch between them by 
~ressing and holding # . · 

- The function of these two selection keys depends on the text 
shown on the bottom line of the display. See figure 2. · 

~ 

~~~:@ll1111i1111Nl'iliiili~~!f.r,..·:- ';;-,..--. 

ji Note: Hold the phone as you would any other telephone 1 with the antenna pointed up and over your shoulder. 

: As with any other radio_transmitting device, do not touch , 
~ the antenna unnecessari ly when the phone is switched ,. · 
~-' on. Contact with the antenna affects call quality and may . · 
· cause the phone to operate at a higher power level than 
~ otherwise needed. • 
~ '( 

-~~~~II!!!!Wm~;:.d .. ;···· .. ·· 

To use the selection keys 
When this manual instructs you to press a command key, press the selection 
key under the cor:nmand name. For example, pressing M enu, i.e. the selection 
key under-the text Menu, gains access to the menu functions, and Names, i.e. 
the selection key under the text Names, to the search functions. The 
commands vary according to the situation and previous selection. 

The selection must often be confirmed by pressing OK. Whenever the Back 
command is shown, it can be used to return to the previous menu level 
without making any changes. 

Figure 2 

Display indicators 
The display indicators inform you about the current operation of .the phone. 
The indicators described below are shown when the phone is ready for use, 
with no characters entered by the user on the display. 
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OPERATOR 

Ind icates in which cellular. network the phone is currently used. 

'f and bar 

Indicates the current signal strength at your location. The more bars are 
visible, the stronger is the signal. 

C and bar 

Indicates how much charge there is left in the battery. The more bars are 
visible, the more charge is in the battery 

To make a call 
You can make and receive calls only when the phone is switched on, the 
communicator has a valid SIM card fitted, and it is located in the service area 
of the cellular network. 

--:~~;~~;~=~~:;:~~~;~·;~~ :'··-
I may be made without a SIM card. Check wit~ ;~ 

I your netw~rk operator. For more information ·1'1 
about mak1ng emergency calls, see .1 

I "Emergency calls" on page 175. ~ 
.l:a:iiiltif!ifti1Nifai!!:iliii!ii&11Jll!f~~=.,.,!-·•~ y • 

1 Key in the area code and the phone number of the person you wish to call. 
If you make a mistake, you can remove the digits one at a time by pressing 
Clear repeatedly, or clear the whole display by pressing·and holding Clear. 

For international calls, start by pressing * twice quickly. The 
international call character+ appears on the display, which informs the 
network centre to select the country-specific international prefix. Enter 
the country code; area code and the phone number. 

2 Press ~ to dial the phone number. 

3 When the phone number disappears and the text Ca//7 is shown, the ca ll is 
connected. 

When a call is active, you can use the v and A keys to lower or raise the 
volume level of the earpiece. 

~~~:f~·~~~·~:-T 
~~ear of the device. · I 
~t:Ut!ttb1rtfttt::att1ttr·tttt::.!t.J~~~ ... . 

4 After the conversation, end the call by pressing ~· 
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To answer a call 
1 When you receive a call, the phone gives a ringing tone and the text Call 

flashes on the display. If you have selected a silent profile in Menu 3, on ly 
the keypad and display lights will flash. . 
If the caller can be identified, the caller's name or phone number, and the 
text Calling wi ll be displayed. 

2 To answer the call, press .,....·You can answer the ca ll even while using 
the search or menu functions. 
If you do not want to answer the call, simply press -=-. The ca ller will 
hear the alerting tone change to a busy tone. -

3 After the conversation, end the call by pressing • -:::· 

To manage call~ 
There are a number of functions you can use during a call. To access the 

· functions, simply press Options, -scroll to the function and press Select. 

Menu·- You can access Menu. 

Answer - You can answer an incoming cal l. 

Reject- You can r~ject an incoming ca ll. 

Record- You can record your conversation with this option. See "Recorder 
(Menu 6)" on page 164. 

Hold I Unhold- ·Hold allows you to put the current ca ll on hold, so that 
another ca ll can be made. The original call can be activated again by selecting 
Unhold. If the held call is the only call, you can unhold it by pressing .,.... or · 
the Unhold command. 

0 • 

Swap- This function makes a held call active and put a currently active call 
on hold. You can t.hus alternate between two calls. 

New call- Puts the active call on hold and dials a new phone number. 

Send DTMF- Transm its DTMF tones. See 'To send DTMF tones" on page 152. 

End this call - Ends the activ.e call. . 
End _all calls - ~nds both the active and the held call. 

Mute I Unmute- Switches the microphone of the communicator off or on. If 
the commun icator is· connected to a handsfree car kit, Mute also turns off the 
microphone of the qn kit. 

Conference- If you have one call active and anothe·r ca ll on hold, this option 
merges them into a conference cal l. 

Conference I One to one - Conference includes a . new participant in a 
conference call. During a conference call, One to one allows you to converse 
privately with a selected participant. 

Transfer - The voice call transfer enables you to connect two voice calls 
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together and disconnect yourself from both calls. See "Multiple calls" on page 
62. Note that not all network operators support this function. 

Data~ When you have an alternating call active, this option changes the 
mode of the call from voice to fax. See "Multiple calls" on page 62. 

Voice - When you have an alternating call active, this option changes the 
mode of the call from fax to voice. 

Play last- Plays the last recording made with the recorder. The other party 
will also hear the recording. · 

l 
;lil-=-=-"iil' -~ - ~ =;;:.;.;:=.::.=---=-..em.::-'""'~-~ ... ~ifltrlfHflfHIIJ 11 tJi 'li·tjt;;q~JSTIT'I'W~~~t·-.-~~r··;:· ·•· 

I, Tip : If you have one active and one held call, press ~­
: ·Swap to make the held call active and to· put the , 
) currently active call on hold. In this way, you may f:~­
' converse with one party without ending the other r~ 

call. You can also press ~ to swap between the f! 
calls if no numbers have been keyed in. J. 

-~-amlm'f'm~imih!li'i!llt1wt·1~.1[Jmllx~tua:,a~~,,..,..;.;.., _ _ 

To search for phone numbers 
,. 

You may fetch phone numbers from memory by the name with which the required 
phone number was stored. Note that the phone uses memory (SIM or Telephone) 
which is chosen in the Telephone application by_pressing Menu and Select. 
1 Press Names. 

. . 

2 Key in the name of the person whom you want to call, or the first letter(s) 
of the name. 

3 Press OK. The name closest to the keyed in characters will appear. 

4 If the name found was not the one you searched for, scroll through the 
names with v or A until you reach the correct one . . 

5 To call the person, press ~. If the person has several phone numbers, 
scroll the selection frame onto the one you want and press ~. 

To view the phone num.ber stored with the name 
1 When the desired name is on the display, press Det ail. The phone number 

is displayed. If the person has several phone numbers, scroll through the 
numbers with V: or A until you reach the correct one. 

2 To call the number, press ~. 

To use speed dialling 
Speed dialling ·is a handy way to call frequently-used phone numbers. You can 
define up to eight speed dial numbers in the communicator memory. For 
information on how to set speed dials, see "To make contaCt cards" on page 51. 
1 Key in the number of the speed dial location where yo~ have stored the 
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152 
~ phone number. 
0 

f 2 Press ,-..The phone wi ll display the phone number briefly, and then dial it. 

Speed dialling is not possible during a call. 
:·1Eii'ii:'lmt1PI~~;!~H+t~#~~lm:': ~rtn>r~to~r.t-"'>1'.;:. ~y:·· ·· 

· Note: Number 1 is the speed dial :~ 
·location of your voice mailbox. To j 
call your voice mailbox, press 1 and l 
then ,-. , or j ust press and hold 1. '* 

"' ·.::.-~~1~,,.,. •I'!II'J!'7~-s&:rlC.;~t;·lct,.J·r-~Ai'. '• 

Last number redial 
The communicator stores the last phone numbers you have dialled. 
1 If there are any characters on the display, clear the display by pressing -=-. 
2 Press ,-. .The la.st dialled number will appear on the display. 

3 You can scroll the numbers with v or A until the de·sired number is 
displayed. 

4 Press ,-. to dial the number. 

You can also recall recent received calls and recent missed calls, see "Call 
register (Menu 2)" on page 156. 

To send DTMF tones 
If you need to send long DTM F strings, it is more convenient to send them vi.a 
the communicator interface, see "Multiple calls" on page 62. 

To send DTMF tones manually 
1 Make a call to the desired phone number. 

2 ·Key in the digits you want to send as DTMF tones. The digits are sent one 
by one to the network. DTMF tones can be transmitted even when the 
phone key click !s set off. 

Keypad lock 
The keypad lock prevents the keypad keys being accidentally pressed when the 
communicator is, for example, in your pocket. 

When the keypad is locked, you can answer calls normally by pressing ~. 
During a call, the keypad is unlocked and the communicator can be operated 
in the usual way. After the call, the keypad is automatically locked again. 

The keypad will be automatically unlocked when the communicator is 
connected to a car kit. When the communicator is removed from the car kit, 
vvithout having been switched off, the keypad will be locked automatically 
a gam. 
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To lock the keypad 
1 Press Menu and then the * key within 3 seconds. .· 

While the keypad is locked, the Q-- icon and the Unlock command are 
displayed. · 

To unlock the keypad 
1 Press Unlock and then the * key within 3 seconds. 

H.elp 

~~~j!~!l!lf~l:·~'ffi::f:;~~f::!'!f~~!ml,~lm~f~f:~!+.!J''Y--"~-· 

·!~ Note: When the keypad is locked, . . 
m~ calls may be possible to the 
m emergency number programmed into : f your communicator (e.g. 112 or other . 
~f official emergency number). ~- _ 
:..b::1tm~!lUI!i'litll~·rF~:~;~:.i*imf'll#t.!l:l!tmnm~l~~#!~:t:in. ,~;y ..... 

Most menu functions are provided with a help text, which g1ves a brief 
description of the displayed function. 

To view the help text 
1 Scroll to the menu function about which you want help. 

2 Wait for 10 seconds. The first page of the help text will appear. The text 
scrolls automatically. However, if you want to scroll it manually, press the 
scroll keys or More. 

3 To exit from the help function, press Back. 

To use the menus 
The phone offers a set of menu functions that _allow you to tailor the phone to 
your particular use. In each menu and submenu, you can check and alter the 
settings of functions. The menus and submenus can be entered by scrolling 
the menu or using the appropriate shortcuts. 

You can access the menu funetio.ns even during a call. 

To scroll the menus 
1 Press Menu. 

2 Press either v or A to scroll the list of menus unti l you reach the desired · 
menu. 

3 ' Press Select to enter the menu. If the menu contains any submenus, reach 
the one you want with either v or A · . 

4 Press Select. The selection frame is on the current setting. 
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154 
~ Scroll the list o.f setting options unti l the selection frame is on the desired 

option. 

6 Press 9K to select the option. If you do not want to change the setting, you 
can return to the previous menu level by.pressi ng Back. 

To use menu shortcuts 

All the menus, submenus and settings are numbered. This number is shown in 
the upper right cor~er of the display. · 
1 Press Menu. 

' ' 
2· Key in the number of the main menu under which the desired submenu is 

located. 

3 Key in the number of the submenu where the function can be found. 

4 Key in the number of the desired. setting option. 

For instance, to change the incoming call alert in the general profile to ring 
only once (Menu 3-1-2-1-3): press Menu to ente r the menu facility, 3 to 
enter the Profiles menu, 1 to select the General profile, 2 to personalise the 
profile, 1 to modify the alert tones, and 3 to select Ring on~e. 

To exit from the menu 
1 Press -=- or press and hold Back. 

Menu structu·re 

The following menu table lists the names of the ma1n menus and their 
submenus. Third-level menus are not shown here. 

MENU1 
MESSAGES 1 Received short messages, 2 Info service·, 3 Service 
't' command editor, 4 Voice messages 

CALL. 
1 Missed calls , 2 Received calls , 3 Dialled calls, 

MENU 2 4 Erase recent call lists, 5 Show call duration 't' , 
REGISTER 

6 Show call costs 't' , 7 Call cost settings 

MENU 3 PROFILES 
1 General, 2 Silent, 3 Meet ing, 4 Outdoor, 5 Pager, 
6 Flight. 7 Headset. 8 Car 

MENU 4 SETIINGS 
1 Call settings, 2 Phone setti ngs, 3 ?ecurity settings, 
4 Restore factory settings 

CALL 
1 Divert all voic~ calls, 2 Divert when busy, 3 Divert 

MENU 5 
DIVERT 't' when not answered, 4 Divert if not reachable, 5 Divert 

all fax ca lls, 6 Divert all data calls, 7 Cancel all diverts 

MENU 6 RECORDER 
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Some menu functions are. network service·s, indicated by the 't' symbol in the 
menu table. To use such a function, your network must support it and you 
must subscribeto it. Note that network services are specific to each SIM card. 
If you change the SIM card, and you have not obtained the service for the new 
card, you will not be able to use the service. 

Messages (Menu 1) 
The Short Message·· Service (SMS) is a network service. Contact your service 
provider for details. The phone can be used for listening to vqice messages in 
voice mailboxes and for reading received short messages. However, reading 
short messages is r:nore convenient via the larger display ofthe communicator 
interface .. To send shqrt messages, use the SMS application of the 
communicator. · 

Received short messages (Menu 1-1) 

When you receive a short message, t.he text Message received and the ~ 
indicator V:Jill be displayed and a tone wil l sound, unless the communicator is 
set to a sil~nt profi.le. 

A note is also shown when you receive faxes or mail. To read received faxes or 
mail·, you must use the respective applications of the communicator interface. 
1 To read the message immediately, press Read. To read the message later, 

press Exit. 

2 Press Read again to view the received message. 
The messages are listed in the order they were received. To read the second 
message on the list, press y to.select it and then press Read. 

Once you have read the message, you can press Back or Option. The options 
available in the phon.e are: 

Erase- Erases the selected message from the memory. 

Use number- Copie·s the phone number from the messaqe and moves it onto 
the phone display. You can now ca ll the number with .,. . 

Details- Shows the sender's name or number, the date an·d time the message 
was sent, and the number of the message centre. 

·~J~f.ER~:Ifilt.ti=MP:tr-i+fi=~~ .. :~~ .. ~~*~;.qm1:tG:f~;t.jt:P.:f.R.1-!l-:P+~ :v'""~r .. :··· 

J. Tip: You can dia l the phpne ! i number in the message by 1 
1 pressing .,. while viewing t 
~t;~;'~~::;~:~~~~m~~~'~,;M.:. J . · 

Inf o service (Menu 1-2) . 

This network service allows you to receive short messages on various topics. 
You may read messages on topics that you have pre-defined on the 
communicator interface, see "SMS settings" on page 82. 
1 Press Select to view the list of available choices. 
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~ 2 Use v or A to scroll through the choice list. To get a list of messages, 
0 
it press Read. 

Pressing Select gives you the followi~g options: 

On- Sets info message reception on . 

. Off- Turns info message reception off. 

Topic index- Fetches a list of available topics from the network. 

Read- Shows a list of received info messages. Scroll to the one you want to 
read and press OK. 

Language - Sets the language for the messages. Scrol l to the desired 
language· and press Mark. 

Service command editor (Menu 1-3) 
In t his menu, you can send servi~e requests, such as activation commands for 
network services, to. your service provider. Key in the sequence you want, and 
press Send. 

Voice messages (Menu 1-4) 

. Listen to voice mess~ges (Menu 1 -4-1) 

When you enter this menu, the communicator dials the phone number 
stored in menu 1-4-2. If requi red, key in the access code for your mailbox 
or answering machine wh·en the connect ion has been made. 

Voice mailbox number (Menu 1-4-2) 

The phone nu mber.that you enter here will be dia lled when yo·u select the 
Listen to voice messages function in Menu 1-4-1. A voice mailbox can be 
a network service or your pe rsonal answering machine. You may enter a 
new or edit an existing phone n.umber. The number will be used until you 
change the number again. 

C.all register (Men·u 2) 
In this menu, you can check and erase phone numbers of calls that you have 
missed (Menu 2-1 ), received (Menu 2-2) or dia lled (Menu 2-3). Note that the 
Received calls and Missed calls functions are network services which work 
only in networks that allow you to view the caller's. phone number. 

~~:~Tem=c~~~=~·~r· 
:~ phone 1s switched on and 
l within network coverage. ·~ 
.;,..~·!J.<l/.'!!l'"'~~~;~:tl:·:tl:l:!l:lt __ ..,,;.u-:.•t, ... 
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Erase recent call lists (Menu 2- 4) 

Caution: The phone numbers are erased without warning. You cannot undo 
the operation. 

Show call duration (Menu 2-5) 

In this menu, you can view the duration of your outgoing and incoming calls 
and reset the timers. 

Last call duration (Menu 2- 5-1) 

Shows the duration of the last outgoing or incoming call in hours, minutes 
and seconds, e.g. 00:02:15. 

All calls' duration (Menu 2-5-2) 

Shows the total ·duration of all calls made or received with any SIM card 
that you have used with the communicator. 

Received calls' duration (Menu 2-5-3) 

Shows the total duration of calls received with any SIM card that you have 
used with the communicator. 

Dialled calls' duration (Menu 2-5- 4) 

Shows the total duration of calls made with any SIM card that you have 
used with the communicator. 

Clear timers (Menu 2-5-5) 

Resets all timers. There is no way to UCJdo the reset operation. 

~WIIflf!Rlllf~~tr- . 

I Note: The actual time invoiced for ~-
i calls and services by your service • 

1.: provider may vary, depending upon 
j n~t:-vork features, rounding-off for j8 
; billing ~ t~~~s and so f~~th. _ .. ~~ 
=l~~irt"~l:ffi~-~~=-:TTHF~n;~Oil-.:r. ':'1-•t-=-

Show call costs (Menu 2-6) 

This network service allows you to check various call costs. The costs are 
shown in charging units or units of currency that you have set ·in Menu 2-7- 2. 
The call cost is shown for each SIM card sepa rately. For these settings you 
n~ed the PIN2 code. Contact your service provider for more information. 

Last call cost (Menu 2-6-1) 

Shows the cost of the last, or current, call. 

All calls' cost (Menu 2-6-2) 

Shows the total cost of all calls made with the current SIM card. 
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· Clear counters (Menu 2-6-3) 

Resets all cost counters. Rese.tting requires the PIN2 code. This service is 
not available with SIM cards that do not support the PIN2 code. There is no 
way to undo the reset operation. 

Call cost settings (Menu 2-7) 

Call cost s' limit (Menu 2-7-1) 

This function allows you to limit the total costs of outgoing calls to a 
specified number of charging units or units of the cUrrency that you have 
set in Menu 2-7-2. For this service you need the PIN2 code. 

Changing the call cost limit also requires the PIN2 code. To turn the limit on, 
select On. Key in the cost limit in charging units or currency units. If you defi~e 
the limit in currency units, you can press * or #to insert a decimal point. 

After the limit has been turned on, the number of the remaining units is 
shown on the display when in idle mode. When all units have been used, no 
calls can be made. 

To turn the limit off, select Off. 

~ ~lfflm'!lfil'tiU!!u~!~~"~'' 

j Note: In some networks calls to the 
:! emergency number programmed into your 

i emergency number) may be made even if · 
. there are no ch·aFging units left. :i 
-'!r•t'!f/if:ttffl!t~~!fdff.M!'!!~7!"!!~~~~}' .....J.: -· 

Show costs in (Menu 2-7-2) 

You may select whether the call costs and call cost limits will be displayed 
in currency or charging units. Contact your network operator for the prices 
of charging units. Chan ging t he cal l cost unit requires the PIN2 code. 

To show the limits in currency units, select Currency, or Units to show the 
limits in charging units. If you selected Currency, key in the charging unit 
price. Use * or # to insert a decimal point. Next, enter the currency name. 

Profiles (Menu 3) 
The profile settings are used for selecting the operating environment for the 
communicatm, and for modifying the profile features. One profile is always in 
use. 

To set on a profile 
1 Press Menu. 

2 Scroll with v and " to Profiles and press Select. 
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3 Scroll to the desired profife, for example Meeting. 
4 Press Options. 

5 Scroll to Activate and press OK. The name of the selected profile is shown 
on the display, except when the general profile is selected. 

~t;~a!l'fJti~~-l:.m[l:IUfllli.ill!lll!!'J~I:'ffit':l'~~~·· . ';--. 

ii ip: A quick way to set on a profile is to ~ 
press the ~: key on the phone keypad. ' . 
Press the key again until the selection 
rame is on the desired profile. To select 

l the profile, press and hold ~• . 
1~~~.~~,-~.,~t, .... 

For more information about the different profiles, see "Telephone settings" on 
page 65. · 

To change the profile settings 
1 Go to the Profiles menu and press Select. 

2 Scroll to the desired profile and press Options. · 

3 Scroll to Personalise and press OK. For more information about the various 
profile settings, see "Telephone settings" on page 65. 

Settings (Menu 4) 
Call settings (Menu 4-1) 

Anykey answer (Menu 4-1-1) 

When set on, you can answer an incoming call by pressing any key on the 

phone keypad, except <D or -=-. 
Automatic .redialling (Menu 4- 1- 2) 

When this function is seton and you call a number that is busy or does not 
answer, the communicator will attempt to call the number until the call is 
connected. 

Press -=- to end the call attempts. 

Speed dialling (Menu 4-1-3) 

When set on, you can dial phone numbers stored in the speed dial 
locations by simply pressing and holding the assigned speed dial key. 

Call waiti ng (Menu 4-1-4) 

Call waiting is a network service. Contact your operator for subscriptipn. 
See "Telephone settings" on page 65. 
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Choose Activate to enable can wait ing, Cancel to disable call waiting, or 
Status to show call types with which call waiting may be used . 

Own number sending (Menu 4-1-5) 

You can set your phone number t o be displayed or hidden from the 
recipient of you r call. This function works only in networks that allow you 
to view callers' phone numbers, provided that this service has been­
activated for your SIM card. Do not use this function unless it has been 
act ivated for you r SIM card. 

Choose Preset, On, Off, Next on, ,or Next off. Preset selects the setting, On 
or Off. that you have agreed upon with your network operator. When you 
change t he SIM card, the Preset setting is automatically selected. 

Phone line in use (Menu 4-1-6) 

If your network supports this service, you can have two phone lines in your . 
communicator. You can select which line you want to use for making calls. 
For more information, see "Telephone settings" on page 65. 

Phone settings (Menu 4-2) 

Clock (Menu 4-2-1) 

You can select whether the time is shown on the display. 

Cell info display (Menu 4-2-2) 

When this function is set on, the phone will indicate when it is· using a 
network cell based on Micro-Cellular Network technology. The setting will 
rema in in effect even if t he SIM card is changed or the phone is switched off. 

•:i<uJ:~:tilm>:~IJ:I!Iftllt:lttil:~d!±fa!lt>!itl1 -·4k·. 
L . ..C J Note: The communicator i 
~ con?umes more pow~r 1 
; :.vhen the \ell info display 1 
'Jt iSOn. ~ 
....w.#~.4ik~'l!#~~~41*lmll~m!lmt-· · >4!· .•.• 

Name list (Menu 4-2-3) 

When searching for names and numbers, you can select whether to show 
th ree names, or one name at a time on the display. 

List of own numbers (Menu 4-2-4) 

You can store and manage phone numbers assigned to your SIM card. This 
function is a memory aid, from which you can check you r own phone 
numbers. 

Welcome note (Menu 4-2-5) 

You can write a message of up to 36 characters which appears on the 
display when you switch on the phone. 
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1 Scroll to the Welcome note setting and press Select. 

2 Key in the message. 

3 Press Options and sc~oll to Save and press OK. 

Network selection (Menu 4 - 2- 6) 

The communicator can be set to select automatically one of the cellular 
networks available· in your area. You may also select the desired network 
manually in this menu. 

When. the Automatic option is selected, the communicator tries to utilise 
the network on whic.h it was last registered. Outside of the home network 
service area, the communicator will select one of the networks that have a 
roaming agreement wi th the home network. 

In the Manual mode, when you pick up a network manua lly f rom the 
network list, the communicator will always attempt to register on that 
network. If the communicator cannot reach, or loses contact with, the 
selected network, you are prompted to select another network. 

·rr::~;;;~;=t::::~:~r· 
l! in handy when you want to if: 
l select a particu lar network, ~ 
j e.g. due to lower call charges. ~ 
e~~~-illllli lol<lli'lil!Ht~III#UI~~-J ••• 

Security settings (Menu 4-3) 

The purpose of the security system is to prevent unauthorised use or altering 
of important settings. In most cases, activating or changing the security 
options requires the appropriate access code. See "Security" on page 127. 

t . 
'. 0 • ~[~ii!lJI:jt[!ftl:llll!to*l!t1Ail?f~~;llf'H-<J.:::.•i=":'-

: Note: When security featu res which restrict -- ' · 

, d1al lmg, closed user group, or system lock), 
: · calls may be possible to certain emergency 1. 
·· nu~~ers in some networks (e.g. 112 or other 1! 
; off1c1al emergency number): · . ,f 
Y~~-~~lRIIIWf·~!itt<l!'w---~:·- ·.·· · 

PIN code request (Menu 4-3-1) 

On or 'Off. See "Security" on page 127. 

Voice call barring (Menu 4-3-2) 

Call barring is a network service; contact your operator for subscription. 
See "Telephone settings" on page 65. 

1 Scroll to one of the following barring modes and press Select. 
All outgoing calls 
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All international calls 
International except to home country 
All incoming calls 
Incoming calls when abroad 
Cancel all barrings 

2 If you want to take the selected barring mode into use, scroll to Activate; if 
you want to disable the selected barring mode, select Cancel, or if you 
want to check the status of the barring mode, select Status, and press OK. 

Fixed dialling (M enu 4-3- 3) 

You may restrict your outgoing calls to a pre-determined.set of phone 
numbers,· if supported by your SIM card. When the function is set on, you 
can only caH a phone number which is included in the fixed ' dia ll ing list or 
which begins with the same digits as a phone number on the list. 

You are prompted for the PIN2 code when you try to put Fixed dialling on 
or off, or if you wish to delete, add or edit any phone number on the fixed 
dialling list. 

If you select Numbers, the following options become available: Search, 
Add entry or Erase all. If you select Add entry, you are required to enter 
your PIN2 code and key in both the name and number you wish to add to 
the fixed dialling list. · 

To edit or erase a phone number on the fixed dialling list, select Search and 
key in the name of the person , or the first letter(s) of the name. Press OK 
and Detail to view the number. Select Options, enter your PIN2 code and 
you are given the. choice of either Edit and Erase. 

~r::-~~:!..!:~~o~:f;J::It~:t.t!ttt:t!.tb!lt~~r.d..W:.r.t"'l:f''U<; .. ;:....,jl ••• 

~;Note : The SIM card contents i 
~;cannot be accessed if the · 1 
t Fixed dialling is on. J 

• ;:;:'#f4+,1f., .. b:"x.*tf+)j+f~~Hfl:m:HF"A~.TA+I;r....u.A4&f-Hio+I.&.•H•: ... : . .-t·.- · 

Closed user group (Menu 4-3-4) 

This network service allows you to set the communicator to accept calls to 
and from a selected group of people. For details on creating a user group 
and activating this service, contact your network operator. YoLJ may be a 
member of up to 10 user groups. 

Select one of the following options: 

Preset- Uses a user group that the SIM card owner has agreed upon with 
the network operator. 

On- Uses a particular user group. Ca lls can be made to or received from 
the members of the selected group on ly. 

Off- Cal ls can be made and rece.ived in the normal way. You can use this 
option only if you are entitled to do· so. 
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SIM change security (M.enu 4_..3 -5) 

The same settings can be found in the Security settings. See "Security" on 
page 127. 

Change access codes (Menu 4-3-6) 

In this submenu, you can change the lock code, the PIN .code, the PIN2 
code and the barring password. See "Security" on page 127. 

The access codes may only include the digits 0 to 9. 

System lock (Menu 4-3-7) 

To lock the communicator, press Select and enter your lock code. The 
communicator locks immediately. Even if you remove and replace the 
battery and switch on the phone, the communicator will rema in locked. 

To unlock the communicator, press Unlock and enter the lock code. 

Restore factory settings (Menu 4-4) 

'(ou can reset the settings of the menu functions to their original values. 
When you activate this setting, you will be prompted for your five-digit lock 
code. This function will not affect"stored phone numbers and names, access 
codes, earpiece volume setting, call timers, cost counters, selected application 
tones or short messages. 

Call divert (Menu 5) 
The call divert network service allows you to direct your incoming voice ca lls 
to another phone number when you do .not want to be disturbed, or when the 
phone is switched off or outside the network coverage area. The call diverting 
functions are described in more detail in "Telephone settings" on page 65. 
1 Scroll to one of the fo llowing divert options and press Select: 

Divert all voice calls 
Divert when busy 
Divert when not answered 
Divert if not reachable 
Divert all fax calls 

. Divert all data calls 
Cancel all diverts 

2 Scroll to Activate. You will be asked for the phone number to which you 
wish to divert the incoming calls. 
The Cancel option sets the divert mode off. Status shows what kind of calls 
are being diverted. 
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Recorder (Menu 6) 
With the Recorder you can record your telephone conversations and voice 
memos, and listen to them. The maximum length of a recording is 30 seconds. 
See also "Voice recorder" on page 144. 

ht>·:W.tfit<li<.f~•ff:fi>+UIN!'II;~o<o+~IU '!mAI'·-r~rx:;.>· :< .,_ 

j Note: Local laws may apply to j 
I recording conversations. Do r 
·i ~ot use this feature .ille~~lly. J 
~ •••••• r •• t 'I I ~-'...4..~~~··~·-;....=.- ·-.· • · 

To record your own speech 
~ In the Recorder menu, press Select. 

2 Scrol l to Record and press Select. 

3 To. stop the recording, press Stop. 

To rec<?rd your Telephone conversation 
1 When you have·an active call, press Record. When the recording starts, 

you will hear a tone. 

2 To stop the recording, press Stop. 

To record your telephone conversation when you have more .than 
one call 
1 If you have for example one call active and another on hold, press Options. 

2 Scroll to Record and press Select. When the recording starts, you will hear 
a tone. 

3 To stop the recording, press Stop. 

To play a recording 
1 In t he Recorder ·menu, press Select. 

2 Scroll to Listand press Select. 

3 Scroll to the recording you want to listen to, press Options and th~n Play. . . . 
To play a recording when you have an active call 
1 Press Option. ' 

2 Scroll to Play last and press Select. Or, if you want to play an older record­
ing, follow the steps above. The other party will also hear the recording. 
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Tip: Club Nokia Careline answers questions and offers instructions over 
the phone. You can visit http://club.nokia.com to find the Club Nokia 
Careline phone numbers. See also· the Accessories guide for further 
information on Club Nokia Careline. . . 
You can also -visit Nokia Wire less Data Forum ·at http:// 
www.forum.nokia.com for information and support material related to 
the communicator. 

1. Phone or communicator interface does not start; both displays 
remain blank 

Make sure that the battery is properiy insta lled and ch.arged. 

Make sure that the contacts on the battery and the cha rging. stand are cl_ean. 

The battery charge may be. too low for operation. Check the display and listen 
for the low battery warning tones. Charge the battery as described in 
"Battery" on page 27. If the NOT CHARGING message is displayed, the 
charging is suspended. In that case, check that the temperature of the battery 
is not above +45°C (+ 11 3°F). Wait for a wh ile, disconnect the charger, connect 
it again and retry. If charging still fails, contact your local Nokia dea ler . . · 

2. Power ·comes on, but the phone does not work 

Rebo0t the communicator by removing the battery and replaci ng it again. 

Try charg ing the communicator. If you see the bat tery charging indicator on 
the phone but the phone does not wo rk, contact your local Nokia dea ler. 

Check the field strength indicator: you might be outside the network service 
area. See the an~'.A{er. to prob lem number 6. 

Make sure that the te lephone se rvice is activated for your SIM ca rd. 

Check if t here is an error me?sage on the display after switching on. If so, 
contact your local dealer. · 

Chec.k that the SIM card. is correctly installed, see :'First start -up" on page 17. 
. . 

3. Communicator interface does not activate or applications stop 
responding · 

Close the cover and open it again. If this does not help, close the cover and 
remove the battery. Replace the battery and open the cover again. Wait whi le 
the communicator performs a self-test and starts. 

Try cha rging the communicator. 

See also problem 4. 
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g- 4. Internal memory or sy~tem error~ ·;:; 

] Sometimes, for example, removing· the battery in mid-operation may cause 
~ errors in the file system of the communicator. If you receive inte.rnal memory 
g or system· error messages and/or reboot prompts, or if the device does not 
.= respond to commands normally, resetting the communicator helps you 

recover from most of these problems. Try the reset operations in the order 
they have been listed: if checking the file system does not help, try removing 
temporary files, or format the file system. 

To reset the communicator 
1 Close the cover. 

2 Remove the battery. 

3 Remove the memory card if inserted. 

4 Place the connector end of the battery in the battery cavity, but do not 
press the other end in place yet. Do not let the battery slip from its place. 
The connector end is the one with the four metal strips. 

5 Open the cov~r. 

6 Press and hold down the required key combination (see below in this topic 
4) and simultaneously push the battery end of the communicator down, so 
that the battery clicks into place. Hold down the keys until you see 
progress messages or a confirmation prompt on the display. 

· 7 In some cases you must confirm the action by pressing a command button. 

After the reset, the communicator will reboot and start normally. 

To check the fil.e system 

Symptoms: The Memory application in the System application group shows 
too much (over 2 megabytes) or too little memory, even if you have just 
removed some documents, or the communicator applications crash when 
opening a document. 

Key combin·ation: Shift-Tab-left arrow 

Caution: If there are problems in the file system, the corrupted files will be 
removed. If there are no problems, this operation does not affect any 
documents or settings. 

To remove temporary files 
Symptoms: The c.ommunicator is in a reboot cycle or a note saying that an .ini 
file is corrupted is displayed. 

Key c::ombination: Shift-Tab-right arrow 

Caution: All temporary files will be removed. The Docum~nt outbox will be 
cleared, the default application settings restored, but for example, the SMS 
message centre number, Internet access point and Remote mailbox settings 
will be lost. 

Stored documents will not be affected. 
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To format the fil e system 

Symptoms: The communicator is in a reboot cycle or does not boot up. 

First, check that your battery is not empty. 

Key combination: Shift-Tab-F 

Caution: Formats the file system. All data you have entered will be lost. This 
operation wil l restore your communicator to the state it was in at the time of 
purchase. 

Remember that backed up data can be re~tored in all cases. 

If these measures do not help, contact your local dea ler. 

5. Cannot make or receive calls 

Make sure that the phone is not off. Close the cover and switch on the phone. 

If you get the message INVAliD SIM CARD, your SIM cannot be used in the 
. commun icator. Contact you dealer or network operator. 

Check the status of your call barrings and diverts, see "Telephone settings" on 
page 65. 

The phone may be busy: data or fax is beir]g sent or received, or the 
communicator is being used as a fax modem. Wait for the data/fax 
transmission to end, or drop the call by pressing the -=- key on the phone 
keypad. 

6. Call quality is poor 

Your location may not allow better call quality. This problem may occur 
especially in a moving car or train. Move to a location where the radio signal 
reception is better. See "Facts about cellu lar data transmission" on page 14. 

Reception is usually better above ground level, outdoors and while stationary. 
Sometimes even moving the communicator slightly will imprQve reception. 
You can also try using the communicator in the handsfree mode, see 
"Handsfree mode" on page 61. Remember to turn the antenna to an upright 
position. 

7. Cannot divert or bar voice, fax or data calls 

You may have not subscribed to the service in question, or it is not supported 
by the network, or. the message centre number and the number to which you 
want to divert your ca lls may be missing or incorrect. 

Fax diverts and barrings are set in the settings of the Fax application. Data 
barring is set in the Internet settings. Data calls cannot be diverted. 

8. Cannot select a contact 
If you cannot select a contact in the Telephone, Fax, SMS or Mai l directory, the 
contact card doe·s not have a telephone number, fax number, wireless phone 
number or an e- mail address. Add the missing information to the contact card · 
in the Contacts ap,plication. 
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9. Cannot send or receive faxes, short messages or mail 

Make su re that you have subscribed to these network services. 

The phone may be off, or th~. communicator is low on memory. See problem 16. 

The number format you use may be invalid, or the called number has not 
answered within 10 tries, or you are cal li ng to a wrong phone number. · 

The phone may be busy: data or fax is being sent or received, the communicator 
is being used as a fax modem. Wait for the data/fax transmission to end, or drop 
the call by presslng the -=- key on the phone keypad. · 

Fax/data ba rrings or fax diverts may be active. Fax barrings/diverts are set in 
the settings of the Fax application, data barrings are set in t he Internet 
settings. 

Fax reception: Your SIM card may not have a fax number. 

Mail reception: Your SIM card may not have a phone number for data 
connections. Contact your service provider. 

Mail sending : You have not subscribed to a remote mailhox service, or the 
mai l server delivering your mail does not comply with the SMTP protocol. 
Contact you r e-mail service provider. If you are using the Upon request 
sending opt ion, mail must be sent in the Document outbox, see "To send mai l" 
on page 92. 

If you have problems sending mail with attachments, select Cancel Sending 
and try again. If this does not help, try the key combination Shift-Tab-right 
arrow. Some mail attachments can take up a significant amount of memory 
and therefore freei'ng some · memory by deleting something from your 
communicator memory might also hei'p. · 

Short message sending: You have not subscribed to the Short Message 
Service or t he message centre number-is missing or incorrect. Contact your 
service provider. · 

The reason for fai lure may also depend on the network: the network does not 
support SMS, fax, or data/mail; the network is out of order or busy; the field 
strength is not adequate for sending. · 

1 0. Cannot establish a Terminal or Internet connection 

The Internet, Mai l, WWW, or Terminal settings and configurations may be 
missing or incorrect. Check your Internet access point confi gur~tio n s in the 
I nterne·t ma in settings. Contact your Internet service provider for the correct 
settings. See "Internet settings" on page 86. 

If you receive internal error messages, remove and replace the battery and try 
again. If the problem persists, see p~oblem 4. 

If you receive service provider error. messages when connecting to your 
Remote mailbox, contact your remote mailbox service provider. Your Remote 
rna ilbox may con tain corrupted mail messages or the mail server settings may 
be incorrect. 
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11. Infrared problems 

The communicator may be connected to a PC, laptop, printer, digital camera, 
wireless phone or another communicator via the infrared link. · 

If you are using the PC Suite for Nokia 9110 Communicator progral'l) on your 
PC, or if you want to receive data from another communicator or a digital 
camera, you will have to start the Infrared activation application on your 
communicator before the connection is made. See "Infrared activation" on 
page 131 . 

If you are using the Nokia Communicator Server program on the PC, the 
infrared connection is established automatically when you use one of the PC 
connectivity applications of the communicator. 

The PC to which you want to establish the connection must have an lrDA 
compatible infrared port; installed and activated lrDA drivers; and Microsoft 
Windows 95. For more information on lrDA drivers and their use in Windows 
95, contact Microsoft. 

For further information, see the Documentation section on the CD-ROM in the 
sales package of the communicator. 

12. Printing problems 

Lf you are using the infrared connection, the infrared port of the printer must 
be compatible to the lrDA standard. See "Document features" on page 34. 

If you fail to establish an infrared connection, transfer the file to a PC and use 
the PC to print the document. Alternatively, you can fax the document to the 
nearest fax machine. See "To send faxes" on page 71. 

Check that your printing settings are correct, see "System settings" on page 125. 

You may be using an incorrect printe~ driver, see "Document fea tures" on page 34. 

13. PC connect ivity problems 
Make sure that the correct PC connectivity program is installed and running 
on your PC. See chapter 4 "Computer connectivity" on page 39. 

Check the cable or infrared connection used. If you -use an infrared 
connection, theIR ports must be facing each other. 

Check that you are using the correct COM port. 

14. Fax modem problems 
.... 

When you use the communicator as a fax modem, make sure that the 
communicator and the PC use the same baud rate. If you use the infrared 
connection, the baud rate is set automatically. If ·you use the cable 
connection, set the baud rate in the Fax modem settings. For the PC, the baud 
rate is set in the connectivity software of the PC. · 

. If you use the cable connection, fully compatible operation with all PC fax and 
terminal software cannot be guaranteed. Consult your dealer. If you have 
problems with your PC fax software, use the infrared connection. 
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If you have problems establishing a data connection with the remote modem, 
try fixing the data transmission rate by using an AT command. Common AT 
commands based on the ETSI 07.07 standard and supported by the Nokia 9110 
Communicator are listed in the atcomm.txtfile on the diskette supplied _with 
the communicator. For information on how to use the AT commands, consult 
the documentation of the telecommunication or fax application that you use 
on your PC. . 

15. Access code problems 
The lock code is included in the sales package of the communicator. If you 
forget or lose the lock code, contact your communicator dealer. 

If you forget or lose a PIN or PUK code, or if you have not recc;ived such a code, 
contact your network operator. · · 

For information about Internet or Terminal passwords, contact your Internet 
service provider. 

16. Low on memory 
If you notice that the memory of your communicator is getting low, or you 
receive a warn ing note about insufficient memory, check the Memory 
application. 
1 Press Details to see what kind of data takes up most memory. See 

"Memory" on page 130. 

2 Make a backup of all important data. 

3 'Remove items which use a lot of memory, such as documents, received 
faxes, or old calendar data, either manua lly or with the Data removal 
application. See "Memory" on page 130. Or you can transfer the items to 
your memory card. 

I 

I:
-~!l;:+;;r...dml:l'l"'•'l''"'...,,.,~ iJuro1h-'~=•er. ·'~...;:r 

{, 

· Note: Downloaded images, l~ 
received faxes, ·and recordings ~~ 

. may take up significant . ~ 
~amounts of memory space. j 
~'-#ll**!*l~tlt4#:tlbllmiHII!W'P'!i"·<t·~···· · 

17. Distorted characters in Terminal 
If the data bits/stop bits/parity settings are different from those defined to the 
data service by the operator, characters may look distorted on the display. 

18. ISDN connection 
If you use an ISDN connection, go to the Internet settings and seled Internet 
acce'ss. Select the access point you use or define a new one. In the Advaf}ced 
settings, go to Modem initialisation. Enter the AT command AT +CBST = 71 on 
the dotted line. · 
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Your Nokia 9110 Communicator is a product of superior design and 
craftsmanship and should be treated with care. The suggestions below will 
help you to fulfil any warranty obligations and to enjoy this product for many 
years. 

When using your communicator, battery, charger OR any accessory: 

Keep it and all its parts and accessories out of small children's reach. , 
Keep it dry. Precipitation, humidity and liquids contain minerals that will 
corrode electronic circuits. · 

Do not use or store it in dusty, dirty areas. Its moving parts can be damaged. 

Do not store it in hot areas. High temperatu.res can shorten the life of 
electronic devices, damage batterie~. and warp or melt certain plastics. 

Do not store it in cold areas. When the communicator warms up (to its normal 
temperature), moisture can form inside the communicator, which may 
damage electronic circuit boards. · 

Do not attempt to open it. Non-expert handling of the device may damage it. 

Do f!Ot drop, knock or shake it. Rough handling can break internal circuit 
boards. 

Do not use harsh chemicals, cleaning solvents, or strong detergents to clean 
it. Wipe it with a soft cloth slightly dampened in a mild soap-and-water 
solution. 

Do not paint it. Paint can clog the device's moving parts and prevent proper 
operation. 

Use only the supplie9 or an approved replacement antenna. Unauthorised 
antennas, modifications or attachments could damage the communicator and 
may violate regulations governing radio devices. 

If the communicator, battery, charger or any accessory is not working properly, 
take it to your nearest.qualifted service facility. The personnel there will assist 
you and, if necessary, ar~ange for service. · 
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Traffic safety 
Do not use a communicator while driving a vehicle. If using a communicator, 
park the vehicle first. Always secure the communicator in its holder; do not 
place the communicator on the passenger seat or where it can break loose in· a 
collision or sudden stop. 

The use of an alert device to operate a vehicle's lights or horn on public roads 
is not permitted. 

Remember road safety always comes first! 

Operating environment 
Remember to follow any special regu lations in force in any area arid_ always 
switch off the phone of your communicator whenever it is forbidd~n to use it, 
or when it may cause interference or danger. 

When connecting the communicator or any accessory to another device, read 
its user's guide for detailed safety instructions. Do not connect incompatible 
products. 

As with other mobile radio transmitting equipment, users are advised that for 
the satisfactory operation of the equipment and for the safety of personnel, it 
is recommended that the equipment should only be used in the normal 
operating position (held to your ear with the antenna pointing over .your 
shoulder). 

Do not point the infrared beam at anyone's eye or allow it to interfere with 
other infrared devices. 

Electronic devices 
Most modern electronic equipment is shielded from radio frequency (RF) 
signals. However, certain electronic equipment may" not be shielded against 
the RF signal~ from your communic·ator. 

Pacemakers: Pacemaker manufacturers recommend that a minimum 
separation of 20 em (6 inches) be maintained between a hand-held wireless 
phone and a pacemaker to avoid potential interference with the pacemaker. 
These recommendations are consistent with the independent research by and 
recommendations of Wireless Technology Research. Persons with pacemakers: 
Should always keep the communicator more than 20 em (6 inches) from their 
pacemaker when the phone is switched on; 
Should not carry the communicator in a breast pocket; 
Should use the .ear opposite the pacemaker to minimise the potential for in-
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terference. 

If you have any reason to suspect that interference is taking place, switch off 
the phone of your communicator immediately . 

Hearing aids: Some digital wireless phones may interfere with some hearing 
aids. In the event of such interference, you may want to consult your service 
provider. · 

Other medical devices: Operation of any radio transmitting equipment, 
including communicators, may interfere with the functionality of 
inadequately protected medical devices. Consult a physician or the 
manufacturer of the medical device to determine if they are adequately 
shielded from external RF energy or if you have any questions. Switch off the 
phone of your communicator in health care facilities when any regulations 
posted in these areas instruct you to do so. Hospitals or hea lth care facilities 
may be using equipment that could be sensitive to external RF energy. 

Vehicles: RF signals may affect improperly installed or inadequately shielded 
electronic systems in motor vehicles (e.g. electronic fuel injection systems, 
electronic anti-skid (anti-lock) braking systems, electronic speed control 
systems, air bag systems). Check with the manufacturer or its representative 
regarding your vehicle. You should also consult the manufacturer of any 
equipment that has been added to your vehicle. 

Posted faciliti es: Switch off the phone of your communicator in any facility 
where posted notices so require. 

Potentially explosive atmosph eres 
Switch off the phone of your communicator when in any area with a 
potentially explosive atmosphere and obey all signs and instructions. Sparks 
in such areas could cause an explo~ion or fire resulting in bodily injury or even 
death. 

Users are advised to switch off the phone when at a refuelling point (service 
station). Users are reminded of the need to observe restrictions on the use of 
radio equipment in fuel depots (fuel storage and distribution areas), chemical 
plants or where blasting operations are in progress. 

Areas with a potentially explosive atmosphere are often but not always clearly 
marked. They include· below deck on boats; chemical transfer or storage 
faci lities; vehicles using liquified petroleum gas (such as propane or butane); 
areas where the air contains chemicals or particles, such as grain, dust or 
metal powders; and any other area where you would normally be advised to 
turn off your vehicle engine. 

Vehicles 
Only quafified personnel should service the communicator, or install the 
communicator in a vehicle. Faulty installation or service may be ·dangerous 
and may invalidate any warranty which may apply to the unit. 

Check regularly that all wireless phone equipment in your vehicle is mounted 
and operating properly. 
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Do not store or carry fl.ammable liqu ids, gases or explosive materials in the 
same compartment as the communicator, its parts or accessories. 

For vehicles equipped with an air bag, remember that an air bag inflates with 
great force. Do not place obj~cts, including both insta lled or portable wireless 
equipment in the area over the air bag or in the air bag deployment area. If in­
vehicle wireless equipment is improperly installed and the air bag inflates, 
se~ious inj ury coul.d result. 

Switch off the phone of your communicator before board ing an aircraft. The 
use of wireless telephones in an aircraft may be dangerous to the operation of 
the aircraft, disrupt the wireless te lephone network and may be illegal. 

Fai lure to observe these instructions may lead to suspension or den ial of 
.telephone services to the offender, or legal action or both. 

Emergency calls 

IMPORTANT! 
The Nokia 9110 Communicator, like any wireless phone, operates using radio 
signals, wireless and land line,networks as well as user-programmed functions 
which cannot guarantee connection in all conditions. Therefore you should 
never rely solely upon any wireless phone for essential communications (e.g. 
medical emergencies) . 

. Remember, to· make or receive any calls the phone must be switched on and in 
a service area with adequate signal strength. Emergency. calls may not be 
possible on all wireless phone networks or. when certain network services and/ 
or phone features are in use. Check with loca l service providers. 

To make an emergency call 
1 If the device cover is open, close the cover: 

2 If the phone is not on, switch it on by pressing the <D key. Some networks 
may requ(re that a valid SIM card is properly inserted in the communicator. 

3 Press and hold the ~ key for severa l seconds to ready the phone for 
calls, and to end possible active data or fax calls. 

4 Key in the emergency number for your present location (e.g. 112 or other. 
official emergency n\Jmber). Emergency numbers vary by location. 

5 Press the .,... key~ 

If certa·in features are in use (call barring, fixed dial ling, closed user group, 
system lock, keypad lock, etc.), you may first need to turn those features off 
before you can make an emergency ca ll. Consult this document and your local 
cellular service provider. 

When making a·n emergency cal l, remember to give all the necessary 
information as accurately as possible. Remember that your communicator 
may be the only means of communication at the scene of an accident- do not 
cut off the ca ll until given permission to·do so. 
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To use this manual 
The wireless phone described in this manual ·is approved for use in the GSM 
networks . 

A number of features included in this manual are called network services. 
They are special services provided by wireless service providers. Before you can 
take advantage of any of these network services, you must subscribe to the 
service(s) you require from your home service provider and obtain instructions 
for their use. You can then activate these functions as described in th is 
manual. The manual activation commands for various services are not 
presented in th is manual (e.g., using the * and # characters for activating 
or deactivating services). T.he . Nokia 9110 Communicator, nevertheless, is 
capable of handling commands given in that form. For these commands, 
please consult with your service providers. 

WARNING! This apparatus is intended for u ~e when supplied with power 
from a Lithium- ion battery and chargers ACP-9E, ACP-9X and ACP-9A. 
Other usage will invalidate any approval given to this apparatus and may 
be dangerous. 

Use only batteries, chargers, and accessories approved by the 
communicat or manufacturer for use with this particular communicator 
model. The use of any other types will invalidate any approval or warranty 
applying to the communicator, and may be dangerous. 

For availability of approved accessories, please check with your dealer., 

When you disconnect the power cord of any accessory, grasp and pull the 
plug, not the cord. 
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A ATcommands 
Operations of a fax modem can be controlled by AT commands. 
These comman.~s give the advanced user an opportunity to control 

· all the features of the modem. A list of common AT commands 
based on the ETSI 0.7.07 standard and supported by the ~okia 9110 
Communicator are available in the atcomm.txtfile on the diskette 
included in the sales package of yourcommunicator.' 

B Barring p.assword 
The barring password is a 4-dig it code needed to change fax and 
voice call barrings, see "Telephone settings" on page 65. The 
password is not located in your communicator ·or SIM card, but in 
the network. You obtain the password from your network operator 
when you subscribe to the call barring service. · 

C Coo.kies 
· Cookies are little pieces of information, given by the server to you, 

to store information about you r visits to a web site. When you 
accept cookies, the server is able to evaluate your use of the web 
site ; what you are interested in, what you want to read, etc. 

D Domain name and Host name 
The terms "domain name" and "host name" are sometimes, slightly 
inaccurately, used as synonyms. In a fully qualified domain name, 
e.g. www.forum.nokia.com, the first part of the name is the name of 
the host, and the following parts are names of domains to which 
the host belongs. Each host name corresponds to a certain IP 
address. Host names are used because they· are easier to remember 
than IP addresses. · 

DTMF (Dual Tone Multi-Frequency) tones 
DTMF tones are the tones you hear when you press the number keys 
on the phone keypad. DTMF tones allow you to communicate with 
voice mailboxes, computerised telephony systems, etc. 

H Hotspot 
A WWW page may contain hotspots, such as selection lists, text 
entry fie lds, and reset/subm it buttons, which enable you to input 
information into the World Wide Web. 
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HTML (Hypertext Markup Language) 
A language used to define the appearance and content of WWW 
documents. 

HTTP (Hypertext Transfer Protocol) 
A document transfer protocol used in the WWW. 

Hyperlink · 

Hyperlinks are used to move from one WWW page to another. 

lAP (Internet Access Point) 
The point where your communicatQr connects to the Internet by 
way of a data call. An Internet access point can be provided, for 
example, by a commercial Internet service provider or by your own 
company. 

Images, in line, external 
Images within a fetched WW\fV page are inline images. Larger 
images are often placed as externa l images and have to be viewed 
separately. : 

IMAP4 (Internet Mail Access Protocol, version 4) 
A protocol used for accessing your Remote mailbox. 

IP (Internet Protocol) address 
All computers and other devices connected to the Internet using 
the Internet P.rotocol have their own individu(!l addresses. The 
address consists of four numbers separated by points: for example, 
131.227.21 .167. 

L Lock code 
The lock code is a five-digit code needed to lock and unlock the 
communicato r. The lock code is also required when you change 
certain settings. You will find the lock cqde on a sticker in the sales 
package of your communicator. Keep it secret and in a safe place, 
separate from the communicator. 

M MCN (Micro-Cellular Network) technology 
Microcells are used for increasing the capacity of wireless networks 
in urban areas. 

MIME (Multipurpose Internet Mail Extensions) 
A standard Internet format which permits including multiple mail 
objects in a single message. The mail objects can be, for ~xample, 
formatted multifont text messages and non-textua l elements, such 
as images and audio fragments. 
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p PIN (Personal Identity Number) code _ 
The PIN code protects your phone from unauthorised use. The PIN 
code is supplied with the SIM card. If the PIN code request is set on, 
the code is required each time the phone is switched on. The PIN 
code must be-4 to 8 digits long. 

PIN2 code· 
The PIN2 code is supplied with some SIM cards. The PIN2 code is 
required to access certain functions supported by the SIM card. The 
length of the PIN2 code is 4 to 8 digits. · -

Plug-in 
A plug-in is. add-on software that can be downloaded from the 
WWW. The communicator uses plug -ins to display a document that 
the WWW application itself cannot show. 

POPJ (Post Office Proto~ol, version 3) 
A common mail protocol that can be used for accessing the Remote 
mailbox. 

PPP (Point t~ Point Protocol) 
A common networking software protocol which enables any 
computer with a modem and a phone line to connect directly to the 
Internet. 

Prot ocol 
A formal set of rules that govern how data is transferred between 
two devices. 

Proxy 
In some networks, the connection between the WWW and the site 
you want to connect to is blocked by a firewall. The firewall 
protects the retwork from unauthorised external access. A proxy is 
an intermediary program that enables access through the firewall. 
A proxy can also serve as a network cache to speed up the fetching 
process. 

PUK (PIN Unblocking Key) cod_e 
The PUK is an 8-digit code supplied with the SIM card. The code is 
required when you want to change a disabled PIN code. If you enter 
an incorrect PUK code ten times in succession, the SIM card is 
rejected and you cannot make or receive any calls, except 
emergency calls. When the SIM is rejected, you will need a new SIM 
card. 
You cannot change the PUK code. If yolJ lose the code, contact .your 
network operator. 
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PUK2 code 
The PUK2 code is supplied with some SIM cards. The code is 
required when you want to change a· disabled PIN2 code. If you 
enter an incorrect PUK2 code ten times in succession, you will not 
be able to access the functions which require the PIN2 code. To use 
these functions again, you will need to obtain a new SIM card from 
your network operator. 
You cannot change the PUK2 code. 

· SIM (Subscriber Identity Module) card 
The SIM card contains all the information the cellular network 
needs to identify the network user. The SIM card also contains 
security-related information. 

SMTP (Simple Mail Transport Protocol) 
An Internet protocol governing the transfer of electronic· mail. 

SSL (Secure Socket Layer) 
A security protocol that prevents eavesdropping, tampering, or 
message forgery over the Internet. Documents using SSL are 
identified with the prefix HTIPS. 

T TCP Port 
Identifies the data port of the destination computer. 

TCP/IP (Transmission Control Protocol/Internet Protocol) 
A protocol that governs data communication in the Internet and in 
the TCP/IP networks. · 

U . URL (Uniform Resource Locator) 
Link information required by the WWW to .connect to a given 
WWW host computer. The URL usually starts with http:// followed 
by www. For example, the Nokia Wireless Data Forum home page 
can be found at http·://www.forum.nokia.com. URLs are often 
referred to with phrases like "Home page location," "Site location," 
"can be found at. .. " 

V Voice mailbox 
A voice mailbox is a network service or a personal answenng 
machine where people can leave you voice messages. 
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Copyright Notice 
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END-USER NOTICE AND LICENCE AGREEMENT FROM PUMA TECHNOLOGY,INC. 

NOTICE TO END-USER: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT ("LICENCE''). 
INSTALLATION OR USE OF THE ENCLOSED PUMA SOFTWARE ("SOFTWARE") ON YOUR COMPUTER 
SYSTEM CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS LICENCE, PROMPTLY DELETE THE SOFTWARE FROM YOUR COMPUTER SYSTEM, 
DESTROY ANY COPIES YOU MADE OF THE SOFTWARE OR ANY INSTALLATION DISKETTES OF THE 
SOFTWARE INCWDED WITH YOUR SYSTEM, AND DISPOSE OF ALL WRITTEN MATERIALS IN YOUR 
POSSESSION REGARDING THE SOFTWARE. Licence Grant: In the case of PC Suite for Nokia 9110 
Communicator Software, Puma grants to You, as an individual, a licence to install and use one copy of 
the Software on a single computer at a time. Your licence to use the Software is conditioned upon Your 
compliance with the terms oflhis Agreement. A Licence is required for each end-user of the Sofiware. 
A Licence is required for each installation of the Software, unless the Software is (i.) installed 
temporarily on a PC owned by a third party so that you can accomplish a file transfer, and (ii.) is 
immediately deleted from such PC. You may make one (1) copy of the Software for archival purposes 
only. 

Copyright: The Software is protected by United States copyright law and international treaty 
provisions. You acknowledge that no title to the intellectual property in the Software is transferred to 
You: You further acknowledge that title and full ownership rights to the Software will remain the 
exclusive property of Puma, and You will not acquire any rights to the "Software except as expressly set 
forth in this licence. You agree that any copies of the Software will contain the same proprietary 
notices which appear on and in the Software. · 

Prohibited Uses: Without obtaining prior written permission from Puma, You may not (a.) use, copy, 
modify, alter; or transfer the Software or documentation except as expressly provided in this Licence; 
(b.) translate, disassemble, decompile, reverse program or otherwise reverse engineer the Software; (c.) 
sublicense or lease the Software or its documentation; or (d.) use the Software in a multi-user, network, 
or multiple computer environment or in a rental, time sharing or computer service business. Without 
prejudice to any other rights, Puma may terminate this Licence if You fail to comply with its terms and 
conditions. In such event, You must destroy all copies of the Software. 

Limited Wa•·ranty: Puma warrants that the Software will perform substantially in accordance with the 
accompanying written materials for a period ofthirty (30) days from the date of purchase. Any implied 
warranties relating to the Software are limited to such thirty (30) day period. 

End-User Remedies: If the Softwa~e does not conform to the "Limited Warranty" section above, 
Puma's entire liability and your sole and exclusive remedy shall be, at Puma's option, either to (a.) 
correct the error, or (b.) help you work around the error. The Limited Warrf!nty is void if failure of the 
Software has resulted from accident, abuse, or misapplication. Any replacement software will be 
warranted for the remainder of the original Limited Warranty period. 
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No Other Warranties: PUMA DOES NOTWARRANTTifATTHE SOFTWARE IS ERROR FREE, EXCEPT 
FOR TifE EXPRESS LIMITED WARRAN1Y IN THE "LIMITED WARRANTY" SECTION. PUMA 
DISCLAIMS ALL OTHER W ARRANTlES Wml RESPECT 10 TifE SOFJW ARE, EmlER EXPRESS OR 
IMPLIED, INCWDING BUT NOT LIMITED TO IMPUED WARRANTIES OF MERCHANTABUJTY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF TiflRD PARTY RIGHTS. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCWSION OF IMPLIED WARRANTIES OR LIMITATIONS OF 
HOW LONG AN h\1PL1ED WARRAN1Y MAY LAST, OR THE EXCLUSION OF LIMITATION OF 
INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY 10 YOU. 
TillS WARRANT¥ GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS 
WIIICH VARY FROM JURISDICTION TO JURISDICTION. 

No LlabUity fot• Consequential Damages: IN NO EVENT SHAlL PUMA DE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF 
TifE PERFORMANCE OR USE OF TifE SOFJW ARE, EVEN IF PUMA HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 

U.S. Government Restricted Rights: Use, duplication or disclosure ofthc Software by any agency, 
department or other entity of the Government is restricted in accordance with FAR 12.212 for civilian 
agencies and DFARS 227.7202 for military agencies. The Software is a commercial product. Use of the 
Software by the Government is further restricted by the tenns of this Licence. 
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Before You Begin 

Chapter 1 : Before You Begin 

This chapter introduces PC Suite for Nokia 9110 
Communicator and instructs you on how to get 
started using the software. 

Topics include: 

· • Introduction to PC Suite for Nokia 9110 Communicator 

+ System Requirements 

• Installing the Software 

• Program Icons 

• The Opening Screen 

• PC Suite Menu Commands 

• Shortcut Commands 

• Component Icons 

• The Preferences Dialogue 

• Communicator Recognition 

• Preparing Your Communicator for a Data Transfer 

• Desk Stand Button Settings 
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PC Suite for Nokia 9110 Communicator 

Introduction to PC Suite for Nokia 9110 
Communicator 

Page2 

PC Suite for Nokia 9110 Communicator is a suite of functions 
that allow for the easy transfer of data between your Nokia 9110 
Communicator and the PC applications you rely on most. 

• PC Suite's Intellisync® component lets you synchronise 
your Nokia 91 10 Communicator's Contacts, Calendar, and 
To-do list applications with a host of popular Windows 
applications. 

• The Contacts application provides a PC Contacts file that is 
compatible, field-for-field, with your communicator's 
Contacts application. 

• The Backup/Restore component lets you back up the data 
on your Nokia 9110 Communicator for safe keeping, and 
restore it if need be. 

• Import/Export functions import and export Calendar and 
Contacts files between your communicator and PC. 

• The Install/Remove component installs software to and 
removes software from your communicator. 

• File Transfer functions let you select, move, copy, paste, 
rename, and delete communicator or PC files in a Windows 
Explorer-type environment. 

r. 

-------------------~--~~~~~--··-··-·-~-----------------------
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Before You Begin 

In order to use PC Suite for Nokia 9110 Communicator, your PC 
must meet the following minimum system requirements: 

+ Windows 95/98/2000, Windows NT 4.0 

+ IBM-<:ompatible 486 PC or higher 

+ 15 MB available hard disk space 

+ VGA monitor or better 

+ CD ROM drive 

+ One available serial or. infrared port 

Follow these steps to install the PC Suite software on yo~r PC: 

1. Insert your CD into your CD ROM drive. The program 
should launch itself automatically. If it does not, continue 
following these instructions. 

2. Click the Windows Start button; then click Run. 

3. Type d:\9110.exe in the command line (substitute the letter 
"d" with the letter of your ~D drive). 

4. Press Enter. 

5. A series of screens is presented. Follow on-screen 
instructions, and note: 

+ You are asked to specify the PC COM port you will use to 
connect your communicator to your PC. If you will be 
connecting via infrared, check the box labelled Infrared 
Port. 
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+ You are given the option of performing a Complete or 
Custom installation. If you choose Custom, you are 
presented with a screen labelled Select Component.s. This 
screen lists the PC applications supported by the PC suite 
Intellisync function. Un-checking an application in this screen 
removes support for that system. (Thus, cutting down on the 
disk space used by PC Suite.) 

Note: .If you un-.check a PC application in this screen, but. later 
w!mt to restore S1Jpport for. that.s)'stem, re-instalfPC Su.i"t~ 'and·, 
~h6.c~ the a.Ppli~atioqin t~e $clect.Go~ponent~ sqreen ... CD;?ri't · 
~~installJniellis)'nc before ~e:in~alling.) .To avo~d l<i.sing .. ·., . 
9u~lom .. setti~gs (including fiel.d }tiapping) un-check. PC. Su~e. v 

Program Files in the Select Components screen. Are~·:··., · 
instalhition of the software is the only case in·whic!l:you .·: : .; 
should un-Check PC Suite Program Files: . . ' 

When installation is complete, a program group containing a set of 
PC Suite icons will have been created . 

.- To access the program group, click Programs on the 
Windows Start menu. Then click on PC Suite for Nokia 
9110 Communicator. 
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Before You Begin 

When you install the PC Suite for Nokia 9110 Communicator 
software, a set of icons is created. 

The PC Suite for Nokia 9110 Communicator 
icon accesses the PC Suite opening screen. 

The Help icon accesses the on-line Help system. 

The Readme icon displays a text file containing 
last-minute infonnation not included in the manual 
or Help topics. 

The Uninstall icon can be used to remove the PC 
Suite software from your PC. 
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The first time you 
open the PC Suite 
application, the 
Contacts component 
is open. Thereafter, 
the last-visited PC 
Suite component is 
open when you start 
the software. 

· Page 6 

Click the~ PC Suite for Nokia 9110 Commwticator icon in 
the PC Suite program 'group tp start the PC Suite software. From 
the opening screen, all PC Suite components can be accessed via 
icons or menu commands. 

.. ··:· ::; : .. 

. . . . :.~ .. ,:<:(,/.·.~· :. =.~:.··,:.·~_::/.:-.~·: 
..... . . . ! : .• . • ; ... . :· ~ •' 
:··.· : ,• •• • • • : '1., : -:· •• •• 

:· .· ... ·' 

;:r: 

.PC.SLito 

J7.) : 
·L:J ·· 
' •. '~· ~ I 

"""''"'~(f"-"Crv•=.a·=•,:c.'J"'"""'"'""""""""= """"""'->'" =•=~---r,<~o.-<'lo"""'1"""'""'"' ·e .. ·o·· :-s, · .... t .... "'if"M ··-"'!l···~ ... " .. ID""-.""-;, .... ;t.·"":"~,.,.. .• ,r~H···" r'~~~·.··. ·"1~· ... 'l~~_ .. i· .. ~"" .. · 
• • • t ~ ~: t il.' •. ·· • ~· .t::.~~ ,~t;!i~J'"• ~--·· · u1 e· enu'· · om man s, · ··r'" ..... · .. .~ 
........ ~.J ... ,.~.,1,••l' .. ,rtn•, ...... ,,.~ ......... f~""•I •. ;...J- ~u ...... ~.;.t .... ,. . "'"' ·~,"-ou<Of'~ ~- .• . ,....,.1:-.l,.. . .u:.. .. "' ... 1.t..At"" ... l ... , .. • ; .• . .._ • ,,. t ' . , • • .... . t~J ..... ,, ,. ,_,:r ')',. '+' 

Each PC Suite component displays its own set of command 
menus at the lop of the screen. Refer to the component-specific 
sections of this manual for information on the menus that apply 
to each component. 

rs li~~'i~~t"'~'c' .,.,....,::1:,~\·.,~;mw.f...-..,;,;.i ·;r~,~~~-·~f.-::~,;,. 
L ..... . 9 ~ C.l!_jit.~~Qmm C!Mi~~§K~~~h 
Most PC Suite commands that are executed by mouse-clicking 
on a button or menu item can also be initiated from your 
keyboard. Simply hold down the All key and press the letter that 
is underlined in the button or menu item. 
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Note that you can 
"drag and drop" 
component icons to re­
order. them on the PC 
Suite screen. 

Before You Begin 

Component icons are located on the left side of the PC Suite 
opening screen. These work as follows: 

The Contacts icon starts the Contacts npplicnti_on, 
which installs ~ith PC Suite to provide field-for­
field compatibility with your Nokia 9110 
Communicator's Contacts application. 

The Synchronise icon accesses the Intcllisync 
component, which synchronises, imports, or exports 
data between records in your communicator and PC 
application. 

The Import/Export icon accesses the PC Suite 
ImportJExport function, which transfers Calendar 
and Contacts files between your communicator and 
your PC. 

The Backup/Restore icon accesses PC Suite's 
Backup and Restore functions, which can be used to 

· backup and, if need be, restore, the data on your 
Nokia 9110 Communicator. 

· The lnstaiJJRcmove icon accesses PC Suite's 
Install/Remove component, which can install 
software to, and remove software from, your Nokia 
9110 Communicator's main memory or memory 
card .. 
The File Transfer icon displays a Windows 
Explorer-type dialogue that lets you cut, copy, paste, 
and move files between your communicator and 
your PC. 
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Selecting the P references command from the PC Suite Options 
menu displays the Preferences dialogue. Before using PC Suite, 
make sure the settings in this dialogue are configured correctly. 

P1eteronccs EJ 

+ Select the radio button labelled Serial Cable if you are using a 
serial cable to connect your communicator to your PC. 

+ Select Infrared if you are using infrared communication. 

+ The Communications Port setting specifies the COM port 
you are using to connect your communicator to your PC. If 
you are using infrared, make sure you specify the port that is 
assigned for infrared connection. 
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Before You Begin 

PC Suite functions allow you to configure operations-for 
example, Backup and Intellisync Synchronisations- for multiple 
communicators. 

Because each Nokia 9110 Communicator has a unique ID 
number, PC Suite for Nokia 9110 Communicator has the ability 
to recognise individual communicators when they are connected 
to your PC. 

To configure an operation for a particular communicator, you 
simply connect the communicator to your PC (or establish an 
infrared connection) and configure an operation. Thereafter, any 
time you connect that communicator and give a PC Suite 
command to run a configured operation, PC Suite recognises the 
communicator and runs the operation defined for that 
communicator. 

Naming your Communicator 
The very first time you connect a particular communicator to 
your PC-whether by serial cable or via infrared-PC Suite asks 
you for a Name to associate with the communicator. 

Reg1ster New CommumcBior fll 
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Deleting a 
communicator 
name in this 
dialogue deletes all 
files and settings 
associated with that 
communicator. 

Page 10 

Assigning a name to each communicator allows PC Suite to 
associate each communicator (and the operations that are 
configured for that communicator) with a value that is more 
easily recognised than the communicator's·ID number. 

Pressing the View button in this prompt displays the "Registered 
Communicators" dialogue, which lists the communicators, if 
any, that have been connected and named. 

This dialogue can be used to rename .a communicator, or delete a 
communicator from the list of recognised communicators. 

M;&i!M@IS.J,,i.,!ii.!i§tii.!Z xl 

Note:'Th'e Registered Communicators dialogue can also be _,. 
aceessed from the' Options meriti. ' , ' ··· ' ' ·. · ' ' . ... :·· .. · . 
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Refer to "The 
Preferences 
Dialogue" in this 
chapter for 
information on the 
PC Suite COM port 
setting. 

Before You Begin 

PC Suit~ data transfer operations can occur via serial cable or 
infrared connection. 

To prepare your communicat~r for a data transfer via serial 
cable: Connect your serial cable to your communicator and to 
the appropriate PC COM port. If you are using a desk stand, 
place your communicator in its desk stand with the desk stand 
serial cable connected to your PC COM port. 

To prepare your communicator for a data transfer via 
infrared: Press the System button on your communicator. Select 
m activation on the System menu. Then point your 
communicator at your PC infrared port or adapter. 

If you use a desk stand, you can program the desk stand~ 
synchron~sation button to run the currently configured Backup 
and/or Synchronise operation whenever the program is active. 

Click Desk Stand Button Settings in the Options menu to · 
display the following dialogue: 
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r====-·---·----------·------
Desk stand button £I 

This dialogue contains check boxes labelled Backup and 
Synchronise. Neither is checked by default. 

+ Check Backup if you want the desk stllJld synchronisation 
button to run the currently configured Backup operation. 

+ Check Synchronise if you want the desk stand 
synchronisation button to run the currently configUred 
Intellisync operation. 

If you check both Backup and Synchronise, both operations are 
performed when you click the desk stand synchronisation button, 
with the Backup operation occuning first. 

Click OK to save your selection(s) and exit the dialogue. 
Clicking Cancel exits the dialogue without saving. 
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The Contacts Application 

Chapter 2 : The Contacts Application 

PC Suite for Nokia 9110 Communicator's 
Contacts component lets you create, edit, and 
update contact cards like those on your.Nokia 
9110 Communicator, ·and transfer them between 
your PC and your communicator. 

Topics in this chapter include: 

• Using the Contacts Application 

• The Contacts Main Screen 

t Opening and Saving a Database 

• Creating a Contact Card Template 

• Adding Contact Cards 

• Card Menu Commands 

• Editing Contact Cards 

• Editing Contact Card Fields .• : 

• Adding Pictures to Contact Cards 

• Creating and Editing Contact Groups 

• Finding and Filtering Contact Information 

• Importing Records from Another Da~base 

t Updating to your Communicator· 

• Updating.from your Communicator 

• Synchronising your Contacts 

• Contacts Menu Conimands . 
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Using the Contacts Application 

To sort cards 
alphabetically by name, 
click on the Name 
heading in the lower 
part of the screen. 

Cticking the Name 
heading toggles 
between alphabetical 
and reverse­
alphabetical order. 

To sort records similarly 
by Company, click the 
Company heading. 

Page 14 I 

PC Suite for Nokia 9110 Communicator's Contacts application 
lets you create, edit, and update contact cards like those on your 
Nokia 9110 Communicator, and transfer them between your PC 
and your communicator. 

To access the Contacts application, click on the Contacts icon in 
the PC Suite opening screen. 

The Contacts main screen contains two windows. The lower 
window contains all the contact cards in the selected database. 
The top window shows the open contact card. 

To open a contact card, click on a Contact name in the lower 
window. •r 
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When you save a 
database, attached 
.JPG and .BMP image 
files are saved in a 
sub-directory. (Both 
.JPG and .BMP 
images saved in this 
sub-directory are 
converted to 16 bit 
grey scale JPEG 
format files.) 

Changing the Contact 
card template does 
not affect the form of 
existing cards. 

Note that menu 
options are 
sometimes disabled in 
the Field menu. For 
example, when the 
Name field is 
selected, Change 
Label and Delete are 
not available because 
you are not allowed to 
delete or rename the 
Name field. 

The Contacts Application 

To create a new Conuicts database, or open an existing database, 
click Open on the File menu and specify a database name and 
location. Use File/Save or File/Save As to save the current 
database. 

Before you start creating Contact cards, you may want to alter 
tlie default Contact card template. 

Follow these steps to create a template for the Contact cards you 
will create in Contacts: 

1. Open the Card menu at the top of the Contacts main screen, 
and select Template to display the default Contact card 
template. 

Name: Card template 
Company: 

Job title: 
Address: 

Tei(GSM): 
Fax: 

Fax (GSIA):' 
Mall: 
Note: 
URl: 

Possword: 
Member: 

2. In this template, you can add fields, rename fields, or delete 
fields from the default template. Simply select a field in the 
template and open the Fieid menu. 

Field menu options include Change Label, Add, and 
Delete. 

When the template is as you want it, you are ready to add new 
Contact cards to Contacts. 
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Follow these steps to create a new Contact card: 

1. Click Card to open the Card menu. 

2. Click New. This displays an empty Contact card (based on 
the current template) in the top window. 

3. Fill out the card. Use the Enter key or up and down arrow 
keys to move between fields in the card template. (Note that 
as soon as you enter a Name value and move to another 
field, the new Contact card appears in ~e lower window. 

4. Repeat these steps for each card you want to create. 

S. To save the new cards you've created, use the File/Save 
command. 

As described, the Template and New commands on the Contacts 
Card menu let you create a Contact card template and create new 
cards using the current template. 

The complete set of Card menu commands is as follows: 

+ New: Lets you create a new Contact card. 

+ Delete: Deletes the open Contact card, or the Contact card 
selected in the Contacts directory portion of the screen. 

+ Duplicate: ~opies the currently selected Contact card. 

+ Copy Contents: Copies the contents of the currently 
selected card to the Windows clipboard. 

+ Template: Displays the current Contact card template. 
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The Contacts Application 

Editing Contacts cards in the Contacts application is easy. 
Simply select the card you want to edit, select the field whose 
value you want to change, and re-type the value. 

You can also use the Field menu to edit the fields list for a 
particular card. Field menu commands include Change Label, 
Add, and Delete. 

Changing a Field Label 
The Change Label command on the Field menu lets you change 
the current field label to a label selected in a displayed list. 

.· 
Note the text entry field at the lower right comer of list box. 
Typing a value here adds a parenthetical to the value selected in 
the list. 

When you've specified the field label you want to use, click OK 
to redisplay the Contact card. 
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See "The Add Field 
Labels List, • next, for 
more information on 
the list of fields that 
you can select. 

Page 18 

Note that you cannot change some field labels (e.g., Name, 
Company). When such fields are selected, the Change Label 
menu option is disabled. 

Addi~tg a Field 
The Add command on the Field menu lets you add fields to the 
open Contact card. When you give the Add command, a list of 
fields displays. 

Note the text entry box at the lower right comer of the Add field 
dialogue. Typing a value here adds a parenthetical value to the 
field selected in the Jist-for example, Address (Business). 

Once you've selected a field in this list, click OK to add the 
field to the open Contact card. Clicking Cancel exits withour 
adding a field. 

,, 
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The Contacts Application 

''• .. 0 ., ....... :.'.': .~: ..... . -:: ··:. 
... . " ' • ... -.... :·. 

The Add Field List contains the following fields: 

C npany The name of the company where the contact works. 

Jc 1 title The job title of the contact. 

A. dress The address of the contact. 

T• The telephone number of the contact. 

F1 : _:'. 
.. 

The fax number of the contact. 

T1 ·/Fax ' .:. 
,'''\ 

If the contact has one phone number for both the : .. 
telephone and the fax machine, write the number . .. 

' here . 

Mil 
. ··. The e-mail address oft he contact. 

o· MF The DTMF (dial tone message format) string 
needed for communicating with the contact. 

N• le You can add important information such as 
birthday or office hours in this field . 

. . 
U L ,:· .· ..... .. The WWW address of the contact. 

;_,; ::s,vdrcl ... :.~: ' The calendar booking password of the contact. 

R " igJng t.one .. , ; The individual ringing tone set for the contact in 
the Nokia 9110 Communicator. Note that if you set .. an individual ringing tone to one that does not exist 
on the communicator, the default tone is played. 

M mber The group(s) in which the contact is a member. 

Deleting a Field 
To delete a field from the open Contact card, highlight the field 
and give the File/Delete command. 
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The Contacts application lets you add pictures to your Contact 
cards. A picture must first be stored on the PC in the .JPG or 
.BMP format. 

To add a picture to the open Contact card, click on the picture 
frame at the upper right comer of the Contact card, or click 
Image and select Add. This displays a Choose Image dialogue. 

In this dialogue, use standard Windows file location methods to · 
find the file containing the picture you want to use. To select the 
picture file, highlight the filename and click Open. Then click 
OK to add the picture to the card. 

If you want to add just a section of a picture to the card, use your 
mouse to select a rectangular portion of the picture before 
clicking the OK button. 

Removing Pictures from Contacts Cards 
To remove a picture from the opened contact card, click Image 
and select Delete. 
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The Contacts Application 

By default, Contact cards have a Member field. This field 
allows you to specify a group that the contact belongs to. 

When yo).l place the cursor in the Member field, a Select Group 
dialogue is displayed, listing the groups that are currently 
defined. To select from this list, highlight a group name and 
click OK 

To add to or change the Contact Group list, open the Groups 
menu and select Edit. This displays the Contact Group dialogue. 

Contact groups li3 

+ To add a new group to tbi!i list: Click the New button and 
type a new Group name when'prompted. Then click OK 

+ To assign a group in this list to the open Contact card: 
Highlight the group name and click Select. 
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+ To remove a group from the Contact Group list: 
Highlight the Group name and click Delete. 

The Contacts application's Tools menu contains commands that 
let you find and filter Contacts information. 

Finding a Contact 
To quifkly find a Contact card, you ~an search for any text string 
using the Find command on the Tools menu. 

Open the Tools menu and click Find. Then enter a string to be 
searched for. 

When the string is located, the cards ar.e resorted, and the 
Contact card containing the string is moved to the top of the list 
and displayed. If the string occurs in more than one card, 
additional cards containing the specified string are listed 
immediately below the displayed card. 

Getting Contact Information 
Giving the Contact info command on the Tools menu displays a 
dialogue containing general information about the currently open 
database--=e.g., the number of records, the number of defmed 
groups, etc. 
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The text field is 
case insensitive; 
that is, capital 
and lower-case 
letters are 
treated equally. 

\ 

The Contacts Application 

Filtering Contacts into a New Database 
The Filter coinmand on the Tools menu is an efficient and 
versatile tool for filtering contacts from a large database into 
another database. 

You can create search criteria row by row, and you can control 
the relationships between the criteria with the logical operators 
AND, OR, and NOT, and with parentheses. You can add as 
many search criteria as you want. 

At its simplest, a search criterion can be as follows: 

Field= text 

To create a search criterion, you select the name of a Contact 
card field from the Field list, and type in some text. For example: 

Company = Bankers Ltd. 

With this search criterion, all Contact cards that have Bankers 
Ltd. in the Company field would be fetched from the database. 

You can also add wildcards(?) and("') into the text criterion. 

? corresponds to any single character. For example: 

Name= ?im 

finds all Contact cards in which the Name field begins with any 
character and ends with im (i.e. Kim, Tim, etc.). 

"'corresponds to any string of characters. For example: 

Company = Bank* 

searches for Contact cards in which the Company field begins 
with Bank (i.e. Bankers Ltd., Banking, BankSaving). 

You can also select an asterisk(") as the Contact field. For 
example: 
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*=Bank* 

finds Contact cards i~ which any field begins with Bank. 

:Using .the·Logical .. Operators 
I'. ' • ..... ' . 

' ' . . : .. .. .. 
The logical operators NOT, AND, and OR allow you to create 
more complex filters. 

• NOT negates the search criterion. For example: 

NOT Company = Bankers Ltd. 

searches for all Contact cards in which the Company is not 
Bankers Ltd. 

+ AND joins two search criteria together, so that both of them 
apply to the search. For example: 

Name ~ Jamcs 

AND Company = Bankers Ltd. 

finds all Contact cards in which the Name is James and the 
Company is Bankers Ltd. 

+ OR joins two search criteria together, but only one of them 
needs to be true for a Contact card to be selected. For 
example: 

Name = Jamcs 
OR Company = Bankers Ltd. 

searches for Contact cards in which the Name is James or 
the Company is Bankers Ltd. 
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Parentheses can be 
added to filters using 
the second and last 
input fields. 

The Contacts Application 

• • t • ..••• :: • • ~ ~. :. • .• . 0 ;. • ,f..: •• ::. • •• ·: • •• - • ::. • • ·-. -- . . . . . :· ... . . ... . - -

Using parentheses, you can combine search criteria. For 
example: 

Name=James 
AND (Company= Bankers Ltd. OR Company= Global Air) 

finds all the contacts named James who work either for Bankers 
of Global Air. 

NQte::The'closmg parenthesisiS'se1ected iri tb'e'inpuffi'eld >' , ': 
focatb4. onihe ·ra:r .~igbt ·pr 'tli.e :Fjlter- co'nta~~ .. 4i.aiogtie·.'·Note~ .. ·:;: ;:·::=· 

.~o~ev~;; ·.that·it' oniy 't>eoo~e~ avai~abie. wh~n ·a· starting<:'. :.::::'· ;::· .: 
parenthesisis·selected. ·' · · .. . :· ·:·· =·,;.· ... . ··' .:>·:: 

·To Use Filte_r~iig-:.~· .... : ... · .· .. , .. ...... :.'·.· 
••' 

When you open the Filter contacts dialogue, the first row gives 
an example of a search criterion: 

Name=* 

This matches all Name fields in the database. Edit this sample 
criterion using the following steps. Then add additional criteria 
as needed. 

To edit or create a criterion: 

I. If necessary, select a logical operator on the far left. In the 
first row, you can only select NOT. 

2. In the Field column, selec~ a field or a wildcard character. 

3. Enter text (and/or wildcards) in the text input field. 

To create new search criteria, use the Insert key. Remove 
existing ones with the Delete key. 
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Executing the Filter 

The open database is the source file from which records will be 
filtered. To open a different database, click the Browse button 
and select a new file. 

Click the Filter button to perform the filtering operation. When 
the filtering is complete, the results, displayed in a separate 
window, can be saved. 

Note that if you save the filtered records to an existing file, the 
contents of the file are overwritten (you are prompted to confirm 
th~ overwrite). 

N~tei,Pictures (.JPG or .BMP files) are saved in a Contact 
imag~s subfolder of. the·database you 's~ve. · . 

The Contacts application lets you add records from one Contacts 
database into another. Simply give the Import from file 
command on the File menu and specify a file. The records 
(including images) in the file you choose will be added to the 
open database. 

Page 00412



Refer to 
"Synchronising Your 
Contacts" later in this 
chapter for more 
information on how 
the "Update• 
commands ·work. 

The Contacts Application 

The Contacts application's File/Update to Communicator 
command updates your communicator with records from the 
open database. That is, records in the open database that are not 
already contained in your communicator are added to the 
communicator. 

Follow these steps: 
' 

1. Start Contacts and open the Contacts database that contains 
the records you want transferred to your communicator. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. 

If you're prompted to do so, enter a nome for your communicator. 

3. Open the File menu and click Update to Communicator. 
l 

The Contacts application's File/Update from Communicator 
commanq updates the open Contacts database with records from 
your communicator. That is, records ill your communicator that 
are not already contained in the open database are added to the 
database. 

Follow these steps: 

1. Start Contacts and open the database that you want updated. 

2. · Connect your communicator to your PC COM port or 
establish an infrared connection. If you're prompted to do 
so, enter a name for your communicator. 

3. Open the File menu and click Update from 
Communicator. 

' 
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If you were to give the Update to CommunJcator and Update 
From Communicator commands one after the other, each of 
your systems would contain the same set of Contact records. 
However, synchronising records in this fashion can result in the 
creation of "duplicate" records. 

Why? During the updating process, records in your two systems 
are compared. If a record in the system you are updating from is 
not identical, field for field, to a record in the other system, it is 
transferred. This me~ns, for example, that if each of your 
systems has a Contact card for John Johansen, but the phone 
numbers in the two cards are different, a duplicate card 
(containing a different phone number) is created in the target 
systef!l when you give the "Update" command. 

If you want to synchronise your Contact records and avoid the 
possibility of creating duplicate records, use the lntellisync 
synchronisation function described in Chapter 3. 
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The Contacts Application 

Contacts Menu Commands 

iF . ,. ·>,i'E'"·~~l::···~r"" ~ ILE.;< •,<i:.'f:'f~ ·'i; · l'}•'· -· • • "' .. ~. ... ' ;:rr ..... " ·"-' ,Y.J 

Open Opens a Contacts database. 

Save Saves the open database. 

SnveAs Saves the open database to a given 
location. 

Import from file Imports records from another file into the 
open database. 

Update to Updates communicator with records in tire 
communicator open database. 

Update from Updates the open database with Contact 
communicator records from your commrmlcator. 

Exit Exits PC Suite. 

Toggles status bar on and off. 

r ... · · l ., ''"'"!'1-'F"'"+r ·E '"~~ :-~~;w-::.!1{~:SJ!~ ·~·~t~ 

New Creates a new Contact card. 

Delete Deletes the open Contact card. 

Duplicate Copies the open Contact card 

Copy Contacts Copies the contents of the open card to 
the Windows Clipboard 

Template Lets you change the default Contact card 
template. 
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,. , ., .f ...... 1 ... r,1ltc~·«iiiW 
FIEUD!~~~~~\ .~if~:·;.tfl· t~ 

Change label 

Add 

Delete 

Add 

Delete 

Edit 

:~q_Q.t.]]~].~~~i\7. 
Find 

.. 
Contact.lnfo 

Filter Contacts 
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Lets you change the selected field 
label. 

Lets you add a field to the open 
Contact card. 

Deletes the field selected in the open 
Contact card 

Lets you add a picture to the open 
Contact c~rd 
Deletes the picture from the open card. 

ou edit the Grou s list. 

Lets you find a Contact card containing a 
given string . 

Sho)fls you how much data is in the open 
database. 

Lets you conduct an advanced search of 
the open database, and save "matching" 
records to another database. 
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The Contacts Application 

'COMPbNJ±N!ts·lil: ~}!( 

Contacts Starts Contacts application component. 

Intellisync Accesses Intellisync component. 

File Transfer Accesses File Transfer component. 

BackupjRestore Accesses Baclwp/Restore component. 

Install/Remove Accesses Install/Remove component. 

ImportiEx!lort Accesses Import/Export componenL 

bP:iic ,is ~ .; ! F"•il·\ 1 •. ·; ,.,.,,M:·:·!'li 

Desk Stand Button Displays desk stand button options. 
Settings ' 

Registered Lists the commrmicators that have been 
Communicators connected and named 

Preferences Dis.P!!!JJ_s the Preferences Dialozt!!!. 

HELP ~::;" ,,· .. ~, :~~Jll~ 

Conients Displays on-line Help Contents. 

Commands Displays command infomtalion. 

UsinRHelp Accesses Help for on-line Help. 

About PC Suite Displays "About PC Suite" dialogue. 
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lntellisync 

Chapter 3 : lntellisync . 

Jntellisync 's Synchronisation function compares 
records in your Nokia 9110 Communic;ator to 
records .in your PC application. It then makes 
whatever changes are necessary in each system to 
ensure that each contains the same up-to-date 
information. 

This chapter explains how Intellisync works, and 
guides you, step-by-step, through the process of 
running your first synchronisation. 

Sections include: 

• Quick Start Tutorial 

• · Intellisync Advanced Settings Dialogues 

• lntellisync Special Topics 

• lntellisync Glossary 

• Intellisync Menu Commands 

.· 
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Quick Start Tutorial 

Refer to 
"Synchronisation and 
History Files• under 
"lntellisync Special 
Topics' for 
information on how 
synchronisation is 
achieved. 

See "Importing and 
Exporting· Data" in 
"lntellisync Special 
Topics" for 
information specific 
to lntellisync Import 
and Export 
operations. 

Refer to 
"Communicator 

· · Recognition' in 
Chapter 1 for 
information on how 
you can use PC 
Suite for Nokia 9110 
Communicator with 
multiple 
communicators. 
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This "Quick Start" tutorial describes the most basic Intellisync 
dialogues, and guides you through the process of setting up and 
running your first Intellisync synchronisation. For infonnation 
about Intellisync "Advanced Settings," refer to ''Intellisync 
Advanced Settings Dialogues" later in this chapter . . 

Note: F6r.siniplicit)i,.this tti~orial emphasises sy.nchroirlsatioii. _;- ·, 
Hpw~ver; the-steps ShOWn here can also :h'e :used to"confj.gtiie · .... ' .. 
intelllsync.'imports and exporis '·6tdata.' The only difference Is i'n·.: 
~e c~q~ce ·of_il·~~tt9n _in'· the 'rntell_~sync; C~o6s~~Tr~~ator:·:·_, .. ·., .. · .. :. 
dialogue>.-·.: .., · : ·: ·.: .-. :. ·:. ·, ._.:=_,. · ,:.=:· .. _)· · ,,: 

?5-~cn~~:.;., 5'll•,~~~~~~m~1· -~-<-~~'Dfr' ~F~:::m~~;w,:._<-<}Dt. 
~ ync •. ron•s•ng,a,;,a a:l'~!:•:~~:iif. ;~,,,::::w~~]g~~~ 
.;...,-&: -::~u-.-.•.J...U<l".......J-4 .... .:-.:....u.... ·~-...- .... ,,..t... • ,;:,1~;.:.:.;.,.4-~ t.Jt~irrt:.;;·~~«.:.1.:..~«. 

Intellisync is designed to simplify the synchronisation of data 
between your communicator and your PC. Synchronisation can be 
accomplished with little more than the press of a button. Before 
you can execute an operation for the first time, however, you must 
configure the operation you want to perfon:ii. 

Once you have set up your configuration parameters for a 
particular communicator, you never need to configure again 
unless you want to' change the nature of the operation. 

:. 
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Before starting this 
tutorial, read 
" lntellisync Address 
Formats" under 
"lntellisync Special 
Topics" In this chapter. 

c 
Refer to "Remote 
Synchronisation" 
under "lntellisync 
Special Topics• 

for information 
about performing 
remote 

· synchronisations. 

Follow these steps to set up and perform your first 
synchronisation: 

Intellisync 

1. Click the PC Suite for Nokia 9110 Communicator icon in the 
PC Suite program folder to display the PC Suite opening 
screen. 

2. Click the Intellisync icon on the opening screen to access 
Intellisync. The Local tab is selected by default. 

3. Connect your communicator's serial cable to the appropriate 
PC COM port. (If you're using a desk stand, place your 
communicator into its desk stand.) If you're using infrared, 
establish an infrared connection between your communicator 
and PC. 

Ifyou'rc prompted to do so, enter a name for your 
communicator. 

4. Click the Settings button:• 
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Refer to • Address 
Formats• under 
"lntellisync Special 
Topics• for complete 
information on 
selecting an Address 
Format-including 
what you should do if 
none of the formats 
correspond to the 
formatting of your 
data. 
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5. You may be presented with a dialogue containing the tabs 
Format and File. This dialogue only displays the flrst time 
you configure an operation for a particular communicator. 
(Thereafter you can change settings in this dialogue using the 
Contacts command on the Options menu.) 

• In the Format tab, select lhe address format that you are 
using for addresses in your communicator (see margin 
note). 

• In lhe File tab, indicate if you want to synchronise 
Contacts on the communicator's main memory, or on the 
Memory card. If you choose the latter, specifY the file 
you want synchronised. 

When you've made your selections, click OK to display the 
Configuration dialogue. 

The Configuration dialogue contains an "Applications" list 
containing your communicator's Calendar, Contacts, and To-do 
list applications. 

6. Click on the Nokia 9110 Communicator application you want 
to configure. 

7. Click Choose to enter the Choose Translator dialogue. 

• -:· 
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When it's present, 
checking the Apply to 
all applications check 
box at the bottom of the 
Choose Translator 
dialogue configures all 
compatible Nokia 9110 
Communicator 
•applications• with the 
PC application and file 
you selected. If all of 
the data you want 
synchronised is in a 
single file or folder, 
check this option to 
configure all of your 
communicator's 
applications at once. 

For information about 
Options dialogue 
settings, dick the 
Help button and refer 
to the Supported 
Systems on-line 
Help topic f~r the PC 
application you are 
using. 

lntellisync 

This dialogue lists all the PC applications that are compatible 
with the Nokia 911 0 Communicator application you selected. 

8. Specify the application and (if necessary) the file you want to 
synchronise. (Use the Bro~vsc button for file selection to 
avoid making typos when typing in complicated paths.) 

Notes:.}_:· · · , :. .:. 

• ~. ify~.ii.are synchronjsing with Outioo_k, you will specifY-a 
., · foldckinsteacl.'of a file: UsQ the' Browse button for folder ._, 

::·· ,· si~f~~~n~::· ...... ;,::~·':'::~i.:·.·: ,·.v· , .. ·• .... ,, .. _:· :·:_·.:;·.·~;;,'', ,.'.:·::· __ :;· .. ,.':::. ·. 
• If yo~ are synchronising with Sched~e+ 7 .0, you must .. 

1, select-Schedule+ Default (you do pot need to specify a file; 
. the open or l~st. used'-tjle js used t?y:default). If you ar~_.using 

:; .. · Sche4ul~+ .7.0a Of7.5;yOU can ~~!~_feith~r·.~.~ltedu!~ : · ·:.:. 
· · D.efaiilt or· ~cbcdulC+.Br()~se Fil~)1o.weyer/if you want ' .. 

to select a file; you ·must select Schcdule+.Browse File. 
Otherwise the open 'or.last used file is.5elected . ·., ·· 
auioinatically.. ' .... :~... · ·. -~- ·. ~- · 
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9. If necessary, select the operation you want to perform. 
Synchronise is normally selected by default. (Synchronise is 
not supported for ASCII -Text Delimited.) 

10. If the Options button is enabled, click it. This accesses 
special application-specific settings that apply to the selected 
PC application. If necessary, adjust settings in the Options 
dialogue. Then click OK 

11. Click the 0 K button in the Choose Translator dialogue to 
retwn to the Configuration dialogue. 

I'C SUite For Nokld !IIIU [ommunocatoo Conhgurdhon E:J 

r:; 9 Ccntoch Fcrmol 4 

t¥> To·doi:l 

Now the PC application you selected appears next to the 
communicator's application name, and a two-way arrow appears 
between the application names. (A one-way arrow appears if you 
selected Import or Export.) 

Note the check box adjacent to the highlighted applications. By 
default, this box is checked, indicating that the data is activated 
for synchronisation. (If you un-check this box, the data will not 
be synchronised.) 
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Refer to 'lntellisync 
Advanced Settings 
Dialogues" later in this 
chapter for information 
on "Advanced" 
settings. 

Refer to "The Conflict 
Resolution Tab" under 
"lntellisync Advanced 
Settings Dialogues" 
for information on how 
to resolve data 
conflicts during 
synchronisations. See 
"The Confirmation 
Tab' in the same 
section for information 
on the confirmation 
prompt. 

Intellisync 

12. To review or alter setlings or field mapping for a particular 
application, select the Advanced button to access the 
Intellisync Advanced Settings dialogue. (Intellisync provides 
default values for all "Advanced" settings.) 

13. When you're ready to exit the Advanced Settings dialogue, 
click OK or Cancel. 

.• 

14. Repeat steps 6 through 13 for each Nokia 9110 
Communicator application you want to synchronise (not 
necessary if you checked Apply to all applications in the 
Choose Translator dialogue). 

15. When you're ready to perform the operation, click the OK 
button at the bottom of th<:. Configuration dialogue. ., 

16. Click the Synchronise button on the Intellisync opening 
screen. 

17. If prompted, resolve data conflicts. 

18. A confmnation prompt appears, showing you how many adds, 
changes, and deletes will be applied to each of your systems if 
you proceed with the operation. Click Accept to proceed, or 
Cancel. 
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If you use a desk 
stand with your 
communicator, refer 
to "Desk Stand Button 
Settings• in Chapter 1 
for information on how 
you can program your 
desk stand 
synchronisation 
button to execute the 
currently configured 
lntellisync operation. 
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Intelli~y~c:History F iles 

For each set of data you synchronise, a history ftle is used to 
deterii:llne the ~hanges that must be made in each ofyour.5ystems 
ill ord~r ~o achieve ·synchrolusation. This file is created by..the ;' .: _ 
firSt· sJ"nchronisation of the data. Therefore, a "first~ run" ,·::~· ' . _-· 
~cliio~aiion isd_ifferent froll\ (and may take longer ~il) -: '":• ;_ 
su~~quent. Si~~hr<?nisa~ons:. A first~run synchronisation s.~PlY. -­
merges.the contents qf your two systems. The Co1).11ict Res6lut.ion 
settiilg in the Advanced Setti~gs dia)ogue )s used.toresqlve .- .··\·:_­
~onpi~ts _be~een the sysl_<?m~:· .. .. ; .. .,.. .:'; \' .. · .;.': ::: : : · · ·. · .. --

s·e~·:;~th~· coxillict-R~~;l~lio~ r ab" ~d-~r "l~t~ilisy~2 Ad~~c~d' -. 
Settillgs Dialogilcs'' f<;>r iriform!ltion ·'on· the Conflict R~salution_-: ._ .. 
~e~~g.: . .--;·.:_.~ ,, -.: .... : . .: ·. · .. : ,: .;.:·,.,_·:,:. :_;,, 
.F9'r lnfo~ation_ on' h6w histOry files a~e used in the pro'~es~ .bf : .. : -
synchronisation; see "Synchronisation· and HistorY'Fiies": under 
-"hitellisyil.c .. Special Topics."· • ·. · · . . .. · .. ·., ·.' .. 

Now that you have configured a synchronisation, re-exccuting the 
operation is basicalJy a one-step operation. To re-run the 
operation, simply prepare your communicator for synchronisation 
and click the Synchronise button on the Intellisync opening 
screen. 

To run a synchronisation from the taskbar. simply click on the 
·program icon on the taskbar, press the right mouse button, and 
select Synchronise from the pop-up menu. 
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·~ynchronisaiion :}'jo~es : .... , · ~ .-.: .. ·.,: 
• Refer''to "The Filters Tab" under "Intelli$ync Advanced 

Settings Dialogues·~·{or information about filtering records 
·' for 's:Yn~bronisation . . ;. i: .. . =-~: . '. ' : : 
: ~ ' .Dlll'41g.lntellis}incNiansfers of data bCtireen your''.:.·:··~':- . • .· . 
. ,, ·~ 'comniunicator and the Cori'tacts application; plcture's:at'iiched · 
·,,. to Co~t~cts cards !l~e:,ignored.:Use' PC Suite File Transfer 

co~ands to tra~fer :JPG and .B~.filcs between your 
communicator and PC.' · ·. 

· • s4me. Pt .·appli~ati~~;;·h~ye to b,e ruriiii~i dUring .':· . . ;:.~ .• ; ..... · . 
. :·~Chronisations, If you' arc 'g}rn'chrorusing'\vith one of thesi:: ,: 

: .. ·, applications, you ~ay see lnteUi5ync open the' application . . 
· · · d~ng the operation: @efer to the SuppOrted Systems section 
.· of on-line Help for information about .whether or not the 

.:s}rsteroyou'rc usi~g needs to be ppe,~ ?(closed during data ; 
. ,., :·.tr~sf~\s.), ..•. ~ {:'.:· .:·:· · .''·: ~· ··.:.: .. :~··::· :.: .· ··.· .... :::.;· ... ;,·<·: 

·• · Da~a .. can·be tra,nsferred between records'in your · ... ·. • 
communicator and your PC applications because fie.lds'i.n the 
two.srstems arc "mapped" (linked))ntellisync provides 

. default ".field mapping." but you m,ay '~~~ to alter ~lipping 
.. tci re~direct (or prevent) the flow.of.9ata:· R~fer to "The Fielp 
. Mapping DialogiJe" und.er,"Intelligync .. Advanced ·sertmgs :: 

Dialogues:· for complete infomiatiori.. . . . . .. . . . 
• Once you have sync~ronised a paJ!i~ular set of data, changing 

field mapping ca,uses th~. next synchronisation of that da~ to 
. . be; in effect, a first;~:syncbronisation. Refer t~. "~niellisybc 

, .. .::· .History' Files" ·an.Ci :.'Synchiorusation arid Histor}'.Files" in tliis 
': .. chapter for .an expi8p'aii9n of fl~si~'?'n 's)ipch~onisatio~s. : . . . . 

. • When you synchro~~ a Nokia 911 O·Goinmunicator · 
applic~tion, it is awomaticaUy synchronised with all 'sections 
in th~. select~~ PC.applicntion tha.t ore. compatible \\~th that 
appl . .i~::ation. ;' .· ' ... ,.=,,: · .... : ... : .~>·:: , ...... ·. : . :>.: .. · .~ ·>='·,; . .-.:. ··.' 

'• For ~ormation''about how to· perform ~rictirO@sati~n$ .. : .. 
remotely, see "Remote _Synchronisation·~ under '!IDtellisync 
.Special Topics."· · :: .. ... .. 
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I ntellisync Advanced Settings Dialogues 

Refer to the Quick Start 
Tutorial for information 
on the lntellisync 
Configuration and 
Choose Translator 
dialogues. 

Clicking the OK button 
in this dialogue saves 
the current setting and 
exits the dialogue. 
Clicking Apply saves 
without exiting. 
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When you run a synchronisation, the operation is affected by 
settings contained in a set of Intellisync "Advanced Settings" 
dialogues. This section describes these dialogues. 

Topics include: 

+ Advanced Settings Ta~s 

+ The Field Mapping Dialogue 

When you click the Advanced button in the Intcllisync 
Configuration dialogue, the tabbed Advanced Settings dialogue 
for the selected Nokia 9110 Communicator application appears. 

Advanced Sellln!JS loo Calendao ' lt'3 
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If a setting doesn't apply 
to the Nokia 9110 
Communicator 
application currently 
selected In the 
Configuration dialogue, it 
is not presented. For 
example, when the 
Contacts application is 
selected, neither the Date 
Range nor the To-do List 
tabs are displayed . . 

Intellisync 

The tabs in this dialogue contains the following settings and 
features: 

+ Date Range: Determines the range of Date Book items to be 
included in the operation. 

+ To-do List: Determines if all To-do· items, or only pending 
To-do items will be included in the operation. · 

+ Confirmation: Determines when and if a confirmation 
prompt will ·appear before a synchronisation takes place. 

+ Conflict Resolution: Determines how data conflicts will be 
resolved if they are detected during a synchronisation. 

+ Filters: Lets you create filters that exclude some records 
from synchronisation (or import/export). 

The Date Range Tab 

The Date Range setting in this tab determines the range of 
CaJendar items that will be included in a data transfer. 

Advanced Scllrn!)s lor Calendar ' . £i 
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~· ., 

··. 
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You are presented with three options in this ·dialogue: 

+ T ransfer All Scheduled Items: Transfers all dated items. 

+ Transfer Only Future Items: Transfers only future items. 

+ Transfer Items Within a Range of Days: Transfers items 
within a specified number of days before and after "today." 

..,. To select an option, click on the radio button next to the one 
you want. 

..,. If you select the Transfer items with a Range of Days 
option, enter numbers in the boxes labelled Days prior to 
today ~d Days after today. · 

~~~c~ i . · ... ::<; -~~·:· ::>.;_.', :.-::·::: __ : .. :· _·_)·~.-:: . .- · ·.:·:,:-·:_:::__::·:·. >. _.:·:>:: · :-:,. :.:. , :·.·.; :_. ·.,:__:;-,_·~ 
. .... ::-:·:ilie:·''R~ge ·~r D~ys~. optlo~ _aiiows''y~u 1o'c~eate a'relatiye : 
'. :· .. · ctate range'that'_imtom~i~catiJ'nio:Ye~··w!t!l .iinie. :For·eklunple, 
: ·.::- !f'.You _h~ve~~l,~~e4 the :r~~ge~O d!tYS ,ptlor·t~·:~od~y. an4 ,:_ 
:::.: · .. Jo -_days after t~day; :the two ~<mth.ni!ige -a,dju~sjtseJf ....... 
· ·. ·-. iiiitomatica!Iy:·'That is; ·as today:moves·fcir\vlird iii time; :so ·: . 
·>.··does the: ~el~tive d~i~·rang~ . . • .;:··:. ·_:_·.::· ::. ,._: ... :. :· ·.:·,::,..:. ::: _ _..,-::: ·::· ·.:"--: :-\ .. · 

;. -~11~~ -~6~ ~ -~ .~n~h;o~;s~·tl~~.::·i~~~ci; d;~~ ~e;~ ·j~~JJd~d' 
,in-~e:~~~vi~gs __ sy~_chron~~a.tio~ Yf:il( b~.:~~hf~_nise.Ci · . . · .. ::r.:::· 

· ·lvhether or not they fall. withi1i;the·currently speCified date ' 
· ·:: · .. rattg~. {I~t~JJfs}rn~)d.~niUie.s.the~;it~ms·~y iook_ing ~t-~e < 

::·.:~·· li.ist~>IY. file for,t,h~ pi:eviqlis ~nchro#.isation)., No~e;;.--. :: i: ·, ~ < 
· ·, however::tliatoiily.-those·iterris ~haff~ll wit:hin·th'e ·currently· . 
_-.. · :·· ~p~cij/ed ·date:range . ..\iiU'.be:mciUded 'in.ili~ updat~ pf the . • . : 
::.: ::·, histOtY'file· (lmd '¢erefoi:e _sy~~hroflised~i0n·g·.~e n~x( .-;_· .;: 
.. ·. :syrichroriisatioi1-0f the·data ):· · · ·. .'::·:. · . . . .. .' :,' :· • · . '. ;_.. ·· · .. : · .. 

.· 
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Transfer All Items is 
the default setting at 
installation. 

Intellisync 

Tile To-do List Tab 
The To-do setting in this tab determines whether all To-do list 
items or only pending To-do list items will be included in an 
operation. 

Advanced Sellon!)s for T n dn h•t · £3 

~ If you select Transfer All Items, all To-do list items, 
including those mnrked "completed," will be included in the 
operation. · 

..,. If you select Transfer only Pending Items, To-do list items 
that are marked "completed" will not be included in the 
operation. 
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Confirmation prompts 
are only displayed 
during 
synchronisations. 
They do not appear 
during lntellisync 
imports or exports of 
data. 

At installation, both 
options are 
selected. 

Un-checking Confirm 
Record Deletions is 
not recommended. 
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Tile Confirmation Tab 

Before the results of a synchronisation arc applied, you may be 
prompted to confirm the operation. The confirmation prompt­
which lets you proceed with or cancel the operation, display 
details about what will occur, or execute a "full re­
synchronisation"-is a safeguard against accidentally modifying 
or deleting the wrong data. 

The setting in the Confirmation tab determines the conditiQns 
under which a confirmation dialogue appears. 

Two options are presented: Confirm Record Deletions and 
Confrrm Record Changes. 

Either, both, or neither can be selected. 
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A separate 
confirmation prompt · 
is displayed for 
each Nokia 9110 
Communicator 
application you are 
synchronising. 

Intellisync 

... When Confirm Record Deletions is checked, the prompt 
appears if a synchronisation will result in the deletion of 
records . 

..,. When Confirm Record Changes is checked, the prompt 
appears oily time o synchronisation will odd or change 
records . 

..,. If n~ither of these options is checked, a confmnation prompt 
will only appear if the operation will result in the deletion of 
all records from a system. 

This is a typical confirmation prompt: 

Confi1m Calendlll Changes · ~ 

Note the five buttons at the bottom of the Confirmation 
prompt: 

• Accept: Accepts the set of changes shown and continues the 
synchronisation. 

• Cancel: Cancels the synchronisation. , 
\) 
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Refer to "Full Re- , 
Synchronisation• in 
"lntellisync Special 
Topics• for information on 
full rc -synchronisatlon. 
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• Details: Displays a " Details" dialogue box showing a 
detailed description of what will occur if the synchronisation 
proceeds. 

• Re-sync: Performs a full re-synchronisation- in effect, a 
"first -run" synchronisation. 

• Help: Opens the lntellisync on-line Help system. 

The Details Dialogue .··. ! . 

The confirmation prompt that may appear before a 
synchronisation takes place contains a Details button. Use this 
button when you want to review the exact actions that will occur 
if the SYnchronisation proceeds. 

The Details dialogue contains a field-by-field representation of 
each of the records that will be affected by the synchronisation 
and, for each, notes the operation that will take place (Add, 
Change, Delete). 
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Note that both the 
original and the new 
values are represented 
in this dialogue. 

Intellisync 

If changes will occur in both of your applications, a separate 
area of ~he dialogue will be shown for each. 
The operation that will take place for each record is indicated in 
the first column of ~e Details dialogue. 

To se_e more details ~bout any single record, double click on the 
operation for that record. This displays an "Additional Details" 
dialogue. 

No 
NOK18 
Week~ 
1118/00 
Open-ended 
Nono 

~~~e~<::: .':':::~· ::<' .· ... ·. < .-:_·::~'.\:;_.-:·::~·:':-' · , .. ,.:· .. ,': . -~ _ _-.:··_, .. 
•' ·:_ Details' dialogties .chan be resized,. Wn~n you iesi,ie· a .=:-~ . ·.' ... 
.-:,_;:;:dialqgue;·. thep'osition and siZe:.is remember~d 'the' next time . 

-~:::.~-:. iy~~- 4i~f~~~-~ D~tai:~s· -~i!li?~~·:·;~:;:_,~':···~ :: : .. :;:.·y_-.;·:··:_. , ·,.' ;·:-:- ,._.·::·i:~: .. ::.:: 
• : ·. Data in:HAdditional Details'':dialogues ·cati:be ·sortea;in . · ., 
.. :,,, , ·. either·a.~cenditi_g'.or.·d~~ceri<;lfug" or4e.r./bi'~~u'biC. clicki_ng'_on·:. 
·::·:.'.'· the column;head~g· (clickitig the :s~e column head~g . :'·~: 
'··::· a-gak.- ~oristli~cbtiurinill 'theopp~site·or'de_r). · · ···.-:·-'.·, .:=·.:; 
... . :: . ·. -.; . :-:·:~.. . : .. ~: .. :· .. ::. g:,: .. :': ~:. : .. ':~·"' :::·. ;, . :! :. : ~·: ~ .. :_::::'.'· .: ::· ::: .. ,; :: ·;.; .. -~.: ,.=,..:. ~-·: .: ·: 
• .. : .. To s~e thefull :conten~s of2a.{ield whose :va!ue is. ~nca~ed .. ." 
.,·.:··:·_in the Additional Details:.dialogue,. double' Click on tlie field · .. 
·. :· riam~. :Foia c_hang~ Jtiil:t~ ~oth_. tileJoilne~· arid :De~ ·.valoes=.:'. 
· . _are displayed. ::.: : _ ... ·. , . · , ; . .. · ··. · ... ·.-;. . · ·'· 
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To specify a Conflict 
Resolution setting, 
select the radio button 
next to the option you 
want. 

Notify me when 
conflicts occur is the 
default setting. 
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Tlze Conflict Resolution Tab 

When a data conflict occurs during a data transfer, and 
Intellisync can't resolve it using the normal synchronisation 
process, the Connict Resolution setting selected in this tab is 
used to resolve it. · 

Advanced Senongs lor C~lendar . 1:1 

. . . .. . .. .. . ;. : .... ::.: 
·: : '• .. 

A data conflict exists when records in your two systems that 
should be equivalent contain conflicting data in one or more 
mapped fields. 

More specifically, a data conflict exists when two records 
contain the same key field values, but different values in other 
mapped fields. ··~, 
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Refer to "Field 
Mapping and 
Freeform Fields" 
under "The Field 
Mapping Dialogue• 
for information on 
how lntellisync 
interprets your 
communicator's 
Name field. 

Refer to 
·synchronisation 
and History Files• 
under "lntellisync 
Special Topics· for 
information on first­
run 
synchronisations. 
See "Full Re­
Synchronisation• in 
lntellisync Special 
Topics for details 
on full re­
synchronisation. 

Intellisync 

Key Fields .<., ·. ·. ... ' .. · .. ·.·.· . ·'· 

Fields designated as 'ckei are th(;~ that ~e the m~st :·: .. ~: ·. .. 
fundamental to a particular record. For example, First Name and 
Last Name fields are keyJidds in Contacts records,. 

The use of key fields ~:.d~t~tiDA data conflict~ · b 'pre~~ed 
on the following: Whe~ key' fields in a Nokia record matc)l the . 
key f,i~lds in a PC app~icii~on record, other mapped .field,sin~~e .. 
two reeords should also' match. Iil'other words;' if both of your' ... 
sy~~ems .!J.ave an address reeordfor'Ron:Ogg; the .valties.in Tiile;:. 
Company; etc·. should ·match. .. If th~y do rio('{data·c·onflict :· :\.' · 
ex'iSts::. -~ .. l· ·:: ··:.:·:.:::.·:/· :·::::_.:'·· ...... :_ ... :-:.: ; .. :·.,. ~:··:: ... -:: ·.::_.:~:· .. :·._··:: 

Note: Lettef. case counts i~"key fields. Lfyou have~ ~~~rd.fo;',.~.; 
Diana VcmWinkle in your PC application, and one for·Di~ma ·: : 
Vanwinkle in your communicator, Intellisyno does not recognise 
the names (or, therefore;·.the'records) as equivalent. · 
Synchronisation caus~ botli·records to occur in each sys~m. 

Se~ Key Fields in on'~! in~ fl~lp.for information abc,>ut w.hich •;, ... 
:fields are key fields for e~ch:~nt~ type. .. . .· .. : .. , . '· :. : . 

The occasions when the Conflict Resolution setting is needed to 
resolve data conflicts are as follows: 

+ First-run and full-re-synchronisations. 

+ Imports and Exports of data. 

+ When new records have been added to each system since the 
last synchronisation, and those records conflict. (For 
example, if you have added an address record for Brian 
Sawyer to each of your systems, but the Company fields don't 
match.) · 

+ When mapped fields have been edited in both systems since 
the last synchronisation, but edited differently. (For example, 
if you have updated Brian's home phone number in both 
records, but made a typographical error .in one of them.) 
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Notify me when 
conflicts occur is the 
default setting. 

. See "The Conflict 
Resolution Dialogue 
Box,• below, for 
more information 
about the Notify 
setting. 

Note the check box 
labelled "Apply to all 
conflicts." If you check 
this box, the action 
yoJ choose in this 
dialogue will be 
automatically applied 
to any other conflicts 
detected for the 
current Nokia 9110 
Communicator 
application. 
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Conflict Resolution options work as follows: 

+ Add all conflicting items: Adds a new record to each system 
(or, for one-way transfers, to the target system). The original 
conflicting records remain intact. 

+ Ignore all conflicting items: Makes no change to either 
system. 

• Notify me when conflicts occur: Displays a dialogue box 
each time a data conflict occurs, letting you decide which 
data to use on a cas~-by-case basis. 

+ Nokia 9110 Communicator Wins: Uses data from your 
communicator when conflicts occur. Use this option when 
your communicator contains the most current information. 

+ Other Application Wins: Uses PC data when conflicts 
occur. Use this option when your PC application contains 
the most current information. 

T,.e_ Q~mfl.ict_.Resolution Dialogu~ Box . __ _..·; ,. 

When Notify is the Conflict Resolution setting, a dialogue is 
presented each time Intellisync needs help resolving a conflict. 

.<· .. •' 
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The Conflict Resolution dialogue shows the conflicting fields 
from both systems. The field name is displayed in the left 
column. The PC application's field value is in the centre, and the 
Nokia 9110 Communicator application's field value is on the 
right. 

A box at the top labelled "Item., contains 11 key field value. 
This helps to identify the conflicting record. 

If a record in one system conflicts with more than one record in 
the other system, the box to the right of the Item box will say 1 
of 2, or 1 of 3, (etc.), and left and right arrow controls will let 
you switch between conflicts. 

To resolve a conflict in the Conflict Resolution dialogue box, 
you can select one of the following options from the list box 
below the grid: Add, Ignore, Update, or Replace (Import/Export 
only). 

+ Add: Adds a new record to each system (or, for one-way 
data transfers, to the target system). The original conflicting 
records remain intact. 

+ Ignore: Makes no change to either record. 

+ Replace: (Import/Export' only) Replaces the target record 
with a record containing mapped values from the source . 
record. Unmapped fields in the original record will be lost. 

+ Update: Updates one or both records (as necessary) with 
the value or values you have highlighted in the grid. Use 
Update instead of Replace to avoid losing un-mapped fields 
in the target record. 

Conflict Resohitioit Dialogue-Buttons 
.:·::-.:, · ... 

• •• ·~ •• - - • • •• • •• 0 
.: .. ' •' 

The Conflict Resolution dialogue box also contains the following 
four buttons: 

• OK: Initiates the specified action and continues the 
operation. 

• Stop: Takes no action and terminates the operation. 
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• View: Displays a dialogue showing the full contents of the 
selected field. Use this to display complete values when 
lengthy values are truncated in the Conflict Resolution 
dialogue box. 

• Help: Displays on-line Help text. 

~9~flict Resolutiorr_~otes: ·. · ' ,'} -. :··_: :.- .-
:·: .• . . .. ; . . .. ..)., .. 

~ ;:. Refer to "The Sam~ Record Changed _and Delet~d - . ..:~ ~ 
·. · ... :. Pialogue" under ·~rntellisrnc Special Topics;;_for · . ·· . 
,. , .. ,' information :ab~ut ~:·_~peclal -~onflict Resolutirin dia-logue __ 

: ~hat appears \vhen -~ record'b~s been deleted 'iO one System' 
and changed in the oth~r system since the 1~ .. · 
_Synchronisation. · 

• :Remember: Except' for "first-run" synchronisations, the 
"C~mflict Resolution~ Setting is not normally ne~e~ to 

.· :resolve conflicts when you're synchronising your two . . 
:·:·_ .::sY~teri{s,"In ~ost :cases, lntell\syno kri<?w~ how· io:edlt . .' -! ;: 
· . ··· ··records to achieve synchronisation: · · · · .. :. . : 

~ .. , ::~~ict Reiolutio~ is: .i'pplied. uidivid~all~ t~.-~-~ch pair of . · 
:· :' ·Configured applicatioAs: This means that any time you 

.. ·:· chimge the Conflict Re5olution setting, the: change will 
. apply oniy to the 'currently selected appliC.ations. . 

~ :, .'s1r1e;~ i~No~_ify;; '(ili~ ~~~auit) :i(qte o~iy ·se.tti~g ·¢·~·t lets 'you:,.:: 
': :··see each data cohflic(and·deCide'f6ryourself.how1he ': .. · > ,· 
.. '• conflict should be res~lved,'it'is the-recommended setting.' 
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The names of the filters 
you create are shown in 
the Filters tab. 

A pre-existing filter, 
Exclude Private Data, 
lets you exclude records 
marked Confidential, or 
Private, etc. 

To activate a f ilter for 
use, click on it (you can 
only use one at a time.) 
Click <None Selected> if 
you do not want to apply 
a filter to the next 
synchronisation. 

Intellisync 

Tile Filters Tab 

The Filters tab of the Advanced Settings dialogue lets you "ftlter'' 
records for synchronisation, import, or export. 

By default all records in the applications you configure for 
synchronisation are included when you run an Intellisync 
operation (unless they are excluded by the Date Range or To-do 
list setting). 

If you want to synchronise (or import/export) only a subset of 
items, you can filter records using fntellisync 's filtering function. 
t 

For example, the following filter instructs Intellisync to include 
only address records that have a Last Name value starting with A 
through M, and have the Company value of Bankers Ltd. 

t 
Last Name is between A and M AND 

Company equals Bankers Ltd. 
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When you click New, 
you are prompted to 
name the filter before 
creating it. 
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r 

Filters·Tab Coniman~s. : ·- , ... 

The Filters tab contains the following command buttons: 

,·. 
• •• < 

• The New button is used to create a new filter for the currently 
selected communicator and PC applications. 

• The Edit button lets you edit an existing filter. 

• The Rename button lets you rename an existing filter. 

• The Delete button deletes the highlighted filter. 

'• ... 

Clicking the New or Edit button in the Filters tab displays two 
additional tabs: Conditions and Rules. 

The Conditions Tab 

:.~ '·: 

The Conditions tab is where you specifY the condition(s) that a 
record must meet in order to be included in a data transfer. Each 
condition consists of a Field, an Operator, and a Value. 

For example, here are some conditions that could be applied to 
various applications: 

F ield :· . ' Operator :: 
. ~ . 

Vahic(s) . . 
. . 

Last Name is between AandG 

Company equals Global Air 
Title equals President 

·' 

Date is between 01/01/1998 and 07/01/1998 

Start Date on orajier 01/07/98 
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The Rules Tab 

The Rules tab contains options corresponding to the logical 
operators AND and OR. 

AU Conditions must be met = AND 
One or more eondJtions must be met = OR 

Select an option in the Rules tab when you want to include more 
than one condition in a filter. 

Note: Only one logical operator can be applied to any given filter. 
You'ca;.{uot create'filter$ that contain both·AND ani:I'.OR. .:· .. : ? • .• 

By combining conditions with a logical operator selected from 
the Rules tab, you can create filters like the following: 

Date' after 11/06/97 AND 
Time after 14:00 

Company equals Bankers Ltd. OR 
Company equals Global Air OR 
Company equals Software House Ltd. 

The first filter would include only records with date values after 
11115197 and time values after 14:00. (Note that times are shown 
in 24-hour format-e.g., 14:00 for 2 p.m.) 

The second filter would include only records with a Company 
value of Bankers Ltd., Global Air, or Software House Ltd. 
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If you want to change 
the Operator or Value 
entry for a condition in 
this dialogue, change 
the entry and click 
Update. Clicking 
Remove deletes the 
highlighted condition. 
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Creati11g a Filter 
Follow these steps to create a filter: 

1. Cli~k the New button in the Filters tab. When prompted for a 
filter name, type a name and then click OK. This displays the 
Conditions dialogue. 

2. Click the Field button to display the field list for the selected 
PC application. Highlight the field you want to filter on. This 
places it in the Field text box. 

3. Select an operator for the condition by highlighting an 
option in the Operator list box. (See below for the list of 
operators you can choose from.) 

4. Enter a value or values in the Value text box to complete the 
condition. Then click the Add to List button to place the 
condition in the Conditions List in the lower part of the 
dialogue. 
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Note that a logical 
operator will not 
appear in the 
Conditions tab until a 
second condition is 
added. 

The Boolean operators 
is true and is false 
are used for fields like 
Completed? and 
Confidential? that are 
either checked or 
unchecked. 

is true = checked 

is false = unchecked · 

lntellisync 

5. To add other conditions to the filter, click the Rules tab and 
select AU Conditions must be met (AND) or One or more 
conditions must be met (OR). Then click the Conditions tab 
and specify additional conditions. 

6. VJhen the filter is complete •. click OK to save it. 

Conditions Tab Operators 

There are four operator types that may be offered in the 
Conditions tab: String, Date, Time, and Boolean. Choices 
available for each type are as follows: 

.. . . .. 
Sf ing .. D te .. . rlnie, .. Boolean 
starts \vith equals equals is true 
contains does not equal does not equal is false 
does not contain after afler 
equals before · before 
does not equal on or after on or afler 

' is empty on or before on or before 
is not empty is between is between 
is between today minus ? now minus 

days ? minutes 
today plus? . now plus? 
days minutes 
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F.i,It~r~ng Notes:.·~ .. ~:.: .~: ',·;:.: ,., .. :~;:· ·.;;,.: -:: ... , .. , . : ·'····:·.,. ·.:< ·...... -:.·, · · 
• Filtering can .. be appiie<i to I~telliS}rn~ imports .. an~.e~orts as . 

'vell as synchronisatio~. . . . ·· ".'. 
• :_. If .You .filter on a· field tliat is ri.o( m~pped, Irltellisync can .filte~ 
..... on· the PC sid~. btifnot on the .cQ~un,cator ~ide. ·In: other / 
· wordS,' records will' be ·excluded 'from your PC application~"··, 

.. b!Jt not from yo\)(copununic.ator. ~-=·. : ' ': · 
• iryou filter on a;fi~ld that is co~talned in only one·ofyour 
;. : .. systems, the filtehyill only cx~luqe:r~cords in'.$atA$ystem. '· 

• ,• . • " • • • • •,. '·: • • .. ~ • • I' •. ,' ; . :. : :·:· ::. • • ;:. : . . '•' • . . : 

.~ ... You caiinot use.ooth.AND 'and ,OR iri a single:filter .. : .. , : ···::' 
; . - H~wev~. you.cB;Ji"use .the operafoi:i.s between to create::' .. · 

:; conditions t'ike L'ast Name is behveen A and C. This, in . 
effect, says "If Last Name starts with A, or Last.Name starts 
with B, or Last·N!Ulle starts with .C." You can then .. use the · 

. , .·AND operator!~ c~eate .a futer.like'the follo\~ng v,;hich,. in· . 

. ., effect,-does utilise bo~h'logical op~~alors .. ·: .. :: ·. . ·:.' ·... .. . . . .. .. .. . ' 

.. • Last Name is between A and C AND 
· . .. Company equals Kennel Ltd . . : 

... ·•·· .... . . . 

• ':: If you change or ~iect a di.fferendilter after yoJ·~e:nm a 
. ·:, Y. furnchronisation.with Otitlook;'th~ next_syncJrronisation , ~vill · 
'·. · ·. be; in· effect, a· hrst-ritn synchronis~tion: . . , · .. ··:.: · ·. · ·:· 
::-:·' ·. :.• '• .. . . :: .. ... ·.:· . :. . . .. .. .• . ... .. . 
• ·. Afllter only applies to' the Nokia 9110 Communicator and ·' 

' J>C applications that _were select~. in the Configuration 
.,. . dialogue whe~ the filter was cr_eii:ted-e.g., Addr~ss Book, To 
· ... Do. List, etc. Filters.must be created'. separately :for each set'of 

· · ,app)jcat1()ns.you~ant. to.'5ynchfo~se: . . : ,, ..... ·· ; ·: .... : · 

~ :cli~kin8 ~~ a·niter n~~ in ili~ Fil,t~rs tab activat~s ili~t.1iiier 
for the next synchronisation. (Only one can be' selected at a 

.. time.) When a ftlteris active, its name appears in·th.e bottom 
, . '!ight.comer pf'the:~onfigurat~on ,dialogue whe~:th~ -·: . . . 
. •· .. i app\)<falion tO .. \,Vhich it applies is highlighte:d.: ...... · .. '' .: ·. :. : 

• · .. <.CJi~~ ~Non~ s~i~ied;.:-in :th~ FUt~i:i, tab ify~u·d; ~oh~ant to 
apply a filter you've created to the next synchrOllisation. 
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Use the Section 
drop-down list box 
to specify the 
section for which 
you want to display 
field mapping. 

Intellisync 

In order for data to be transferred between your communicator 
and your PC application file, corresponding fields in each 
application must be linked to one'another, or "mapped." 
Intellisync provides default "field mapping," which links 
equivalent fields in your two systems. But you can edit mapping 
to re-direct (or prevent) the flow of data as needed. 

~ To access field mapping for selected applications. click the 
Field Mapping button at the bottom of the Advanced 
Settings dialogue. This displays the lntellisync Field 
Mapping dialogue. 

The Field Mapping dialogue lists communicator fields on the 
left, and PC application fields on the right. Bi-directional arrows 

1 appear between fields that are "mapped," or linKed, for 
synchronisation. 
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lill' To un~map mapped fields: Click on the arrow (or highlight 
the PC field name and double click or press the Spacebar). 

lill' To map adj acent fields: Click bet\veen the fields (or 
highlight the PC application field name and double click or 
press the Spacebar). An arrow appears to indicate that the 
fields are mapped. · 

lill' To map non-adjacent fields: Drag the field in the right­
band column and drop it next to the field in the left-band 
column. 

... To reinstate default field mapping: Click the Reset 
button. 

Field Mappillg Dialogue Buttolls 

The buttons ot the bottom of the Field Mopping dialogue work os 
follows: 

• OK: Saves changes made to field mapping andre-displays 
the previous Advanced Settings dialogue. 

• Cancel: Cancels changes made to field mapping. 

• Help: Opens the Intellisync on-line Help system. 

• Reset: Resets field mopping to the installation default 
configuration. 

: 
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... •.- '• ..... 
Field Mapping Notes: .·. ·: : .·· 

.. :; ·:· "·· 

IntelliS)rric -~Uforces certain field mapp.ing rules. Fo~ ::. :. · 
· exrup.p_le; yo~:. c·annot map ·tjaie fi~lds t~ tinie fi~Jcis." if),ou· .'. 

atteinp_t to·map:incompatibte:fieJcUyp"~~· ari err~r. iil_essage is . 
display~d. · ,· ., . ·. :. .. . ·: ,· · :· , 

• If you _ch~ge field mapping ·aft~r data has been · . ' 
synchi-onised, the subsequent s}rnchronisalion will be, in 
:eff~t, i{f~t-run synchronis~ti?,ii . . : · ·, .. · -::· .. 

:.~( .. :~.: '• , : ·:.::· ... ·::_.:::i ···:.·· ., <·.. :. :: t ·, ~ ·::;. ,: ... :'· ... ~;·:. ' :·:··::·~--~- ...... 

:\. .: .. Fields ·marked· "vith. asterisks' in the Field Mapping dialogue ·: 
·: · .. ':. ~are fields that must be niapped .(or.· their suo-iield's·ini.ist be ' 
.. · mappeo) in order for a data tninster to succeed: If ~arkC!i 

fields are riot mapped, an error message_ is displayed when 
y you atte~?t to exit the Field _M~pping dialogue. . . .. 
~ . ;• ;. . . . .... 

• , Ch_e.ck the S}lpported ~ys.tem; o·n:line I:Ielp,.'topic. for ·t.~e PC :. 
- ~pplic!ltion(s) Y9U: 're u~jng t.o s~e. ifariy speciat:field :. : ·.: .... _ 

' ,, ' mnppillg J,"illes appiy .. (For example,' if your app~cation ... : 
allows fo~ the creation of custqrri fields, the Help.t6p,ic for 
that system should tell you l:ibw.tO map custom fjelds.) ... "" . 

·. 
• Wh~. ad~~ string is .. tran~f~;d_betw~n fieldsi~ yo~· 
· ..... 9,0mmtinicator_arid your PC applic_ati9n, it may .ti.e tnlncat~ 

. ' . '·::-iri ihc.tiirgeffield if it is.too lCngtliy.to:bc aceo_irinioaatoo: u. 
· ·. ·' is not \vise 'to edit truncated data. If you do, the 'Cinta iil the··. · 
· other system wili be tnlncated·after the next · ' 

· synchrqnisation. Refer to "Synchronisation and Data· 
Truncation" under "lntellisyilc Special Topics" for a 
w~rkaround that allows you ~~ -~it truncated text: · i· ... 

, 
·.:. 
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If your freeform fields 
are formatted 
inconsistently, 
synchronisations and 
exports will result in 
the incorrect 
placement of values 
in your PC 
application. 

Select the address 
format that most 
closely resembles the 
one you're using. 
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Field Mappi11g and Freef orm Fields 

When lntellisync transfers Name and Address fields between 
your two systems, it assumes a particular format for your 
communicator's Name and Address fields. 

The default Name format is as follows: 

LAST, FIRST MIDDLE 

The Address format is determined by the Address Format you 
select when you first configure an operation. (Refer to 
"lntellisync Address Formats" under "lntellisync Special 
Topics" for a description of each of the four available formats.) 

If names are not entered into your communicator in the above 
format, and/or if the addresses in your communicator's Contacts 
application do not match any of the available formats, you may 
want to adjust the field mapping in the Field Mapping dialogue 
to direct values between the correct fields. 

For example, if the third line in your addresses is formatted in 
this way: City, State, Postal Code, but the selected Address 
format is Postal Code, City, State, the following field mapping 
scheme would transfer values correctly between your 
communicator and PC: 

: · : (,:.:_::·-:PC Application · .· :-.. _..::: ·_: .: . _. ·: ,. • .. ~ ~-.: 
'...Ll.. . , Po-sta·l.codc . .. '.. : .- ,:: · ·-· 
'llllllllt'7"" <:· :.· _ _-; ... : . , 
...Ll.. _,. · ,; .. 'c·'_ 1.ty .. ; • ·' ;; ·· .. • 
~ .... · •. ~: : ::·; .. · .. . ::=:=,:_ , :..· •. 
~ .: State . . ' · - ' ·- ~ ~ 

Comm1u1ica'tor: 
C'ity ' ·,-: '·.' 
State :';.--; _, .. ,. 

Post!ll :code 
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I ntellisync Special Topics 
This section is devoted to explaining in detail some aspects oflntellisync 
that have only been touched upon in previous sections of this chapter. 

Topics include: 

+ Synchronisation and History Files 

+ Intellisync Terms 

+ lntellisync Address Formats 

+ Importing and Exporting Data 

• Synchronisation and Truncated Data 

+ Full Re-Synchronisation 

• ·The Same Record Changed and Deleted Dialogue 

+ Sync Log Files 

+ Remote Synchronisation 
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An understanding of 
history files and how 
synchronisation 
works is not 
mandatory. Hov-tever, 
you may find this 
information helpful. 

See "The Conflict 
Resolution Tab" 
under "lntellisync 
Advanced Settings 
Dialogues• for details 
on Conflict 
Resolution. 

For additional 
information about 
history files, refer to 
the lntellisync on-line 
Help system. 
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During a synchronisation, lntellisync compares records in your 
communicator application to records in your PC application, and 
makes whatever changes are necessary in each system to ensure 
that both contain the same information. 

If a record hns been added to one system and not the other, that 
record is added to the incomplete system. If a record has been 
deleted from one system and not the other, Intellisync deletes the 
record from the other system. If there are discrepancies between 
re~ords in the two systems, Intellisync uses the most current 
data. It knows which is the most current because it uses a 
"history file" when comparing the records. 

The first time a particular set of data is synchronised, there is no 
history flle. Data from the two applications are simply merged, 
and conflicts between the two systems are resolved using a 
"Conflict Resolution" setting. · 

I 

However, this initial operation creates the history file that will 
be used for subsequent synchronisations. 

How does the history me work? At the end of each 
synchronisation, a history ftle matching the·two synchronised 
systems is created. When the systems are next synchronised, 
lntellisync compares the two synchronised systems to each other, 
and to the history file. If a record in the history flle matches one 
system, but not the other, Intellisync knows that the "conflicting" 
record has been changed since the last synchronisation. It 
therefore applies the change to the other system and to the 
history file. 

In cases where changes have been applied ~o both systems, and 
those changes conflict (for example, if you have added address 
records for the same name to each system, but the phone numbers 
don't match), the Conflict Resolution setting is used to resolve 
the matter. 
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If address data In your 
communicator is not 
consistently formatted, 
end you have the same 
basic data in your PC 
application, you can 
achieve consistency by 
deleting the addresses 
from your 
communicator and 
synchronising with your 
PC application. This v-111 
transfer the contents of 
your PC application 
back into your 
communicator in the 
selected Address 
Format. 
Before doing this, 
however, it would be 
v.1se to backup your 
communicator data as a 
precaution. 

lntellisync 

In order for Intellisync to transfer data correctly between your 
communicator and your PC application, it must assume a 
particular format for freeform Name and Address fields in your 
communicator's Contacts application. 

Intellisync assumes that Name fields are entered into your 
communicator as follows: 

Last, First Middle 

When you first configure an lntellisync operation for a particular 
communicator, you arc prompted to select an Address format. 
Address formats can also be accessed by selecting Contacts on 
the lntellisync Options menu. 

Intellisync offers five formats to choose from-Address Format 
I, Address Format 2, and so on. If none of the formats match the 
format you are using, you can either select the closest format and 
adjust field mapping to account for the differences, or choose 
Format 5, which transfers the communicator's complete Address 
field to a single field in Y?Ur P~ application. 

Refer to "Field Mapping and Freefonn Fields" under "lntellisync 
Advanced Settings.Dialogues':ffor additional information on 
freefonn Name and Address fields. 

Note:· In :~rder.for ~nfelliS)r.nq .tO Suc'ces.s~ll:Y tr8;DS~e~ data .: "· .. 
between your two 5)-istems, 'daia in freeform fields must be,'. ' .. ·~ 
entered in a consistent ~o~at. If your ·rreefonn fields li~ve been · 
entered ~consistently; tl).e results of a synchronisation, import, 
or.expoit will reflect that inconsistency: · ·. 

Page 67 

Page 00453



PC Suite for Nokia 9110 Communicator 

Page68 

Available Address Formats 

.. . . ·.': • .. •: :::=; • .. : ~ 'I· : ~: ... '• .... : ... -~ .. . ~ 
Address Item 1, City, State, Postal Code, Country 

For example: 13 Lewis St., Moose Junction, MO, 45678, USA 

Addr~ss Forrit~t2 ... · ... ·:: 
........... : ••• : . . •. !• •. 

... 
••• 0 

o I o I o _..:~;: I •:'' •: o' :: 

Address Item 1 <newline> 

City, State, Postal Code, Country 

For example: 1312 Lewis St. 
Moose Junction, MO, 45678, 1-JSA 

Address Format 3. .. .. •' 

Address Line I <newline> 

Address Line 2 <newline> 

City, State Postal Code <newline> 

Country 

For example: 1312 Lewis St. 
Suite 34 

... : ... 

Moose Junction, MO 45678 
USA 

.... 
•• •• 0 - • 
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Address Line I <newline> 

Address Line 2 <newline> 

Postal Code, City, State <newline> 

Country 

For example: 1312 Lewis St. 
Suite 34 

. ' ! ..... ~ .'· ·. : . 
:· .• :·: · .... 

45678, Moose Junction, MO 
USA 

Address Form~t 5 

Intellisync 

. ·• :1 

; 

- ..... ·::: 
Selecting Address Format 5 is, in effect, selecting no format. 
This option can be used if you have not used consistent 
formatting in your communicator, or if none of the other formats 
resemble the format you're using. 

When you select Address Format 5, your communicator's multi­
line Address field is transferred to (l single field in your PC 
application, and vice versa. Check the Field Mapping dialogue . 
to see the default mapping. 

Note: Using this format during synchronisations may result .in 
~e transfer of incomplete·a.ddresses from your PC application to . 
your communicator. · 

: ·. ~· 

For example, when Actdresii Format 5 is selected, Intellisync 
maps the communicator'~ Address field to the Address portion of 
a Scpedule+. address. '(A comple~e Schedule+ address includes ., 
Address, Clty,.,Stau~.Postal Code, and Country.) Thus; only.the_. 
(ldifress portion.of a ~chCdule+ address tr~n~fcrs to yoh!'l:J?kia: 
9rio Comrriunicat6r. City, Siate: etc. are ignored. In ord~I: to · 
transfer the. entire Schedulcf1-: a9dress to your cominurncatqr,. you 
would need to enter. the ertt~ 'address into the Address .field. . . . 
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In addition to synchronising your communicator with PC 
applications, Intellisync can al.so perfonn imports and exports of 
data from one system to the other. 

The same procedures that are involved in configuring and 
perfonning a synchronisation are used for importing and 
exporting. That is, you have to set up the Configuration and 
Choose Translator dialogues, and, if necessary, adjust settings in 
the Advanced Settings, Options, and Field Mapping dialogues. 
Once things are set up, the Synchronise button on the Intellisync 
opening screen initiates the operation. The only difference is in 
the choice of the operation in the Choose Translator dialogue. 

+ To import data from your PC to your communicator, select 
Import. 

+ To export data to your PC from your communicator, select 
Export. 

Notes:":·,· · ··. ··., ··· ·. · · .. -:. .. . ..-::'. ·. · :·' ,. :· ... '. :·' · · ··.,. · · ·· ··. 

; · ... : ·(\Yhe~: ~~~ .P.eri~~ :~~ imP.~~·~~:~~k~~. r~1~i·;is;~c .~oes~~{:·;:.: 
. :.:.:·duplicate r:ecords thaf already .ex,st ill bo~h·~~l~ins:Fof ::: .. ;·: 

. :~ :;, ·~ e~ample~· if yo~'~xJ>9rfth~ :eon tents y;oi.ir .~opirininica~or; s ·:: :: ·. ;:· 
:': ·:.:·: .. C:ontacts application)o ·yout:J~C; records·t!lai-are alie8,cti··~'>; 
. · , .. =:-: conta~e(fin l:io~h::SY,~ems ar~ no~ ~qnsferred.1.o. the f.C ·fil~ . .-.;: ·, 
~ ··~,..r~·a · sin~i; hilerati~~. i~u .c~·~~~r6·~ cifr~i~ni:;jJ~~: 6r:~;fu·,·, 
· ... : ,· transfers. For: example',: in one op!!ration,.:you caii.-;inpon mto . 
. : ... yom 9omm4fiicato.r's.Coiit~cts~app!i.cati6n·, expo~t'Caleridat: ::· 

:;:·.' it;lfonnation, a9~·sync~~(J~.fs~. Y9Ui-.T.o' po;s. jt;s siinpiy· ~ ::·,:·:. ·.' 
' .. v:: rrintter or:.,vliich.operaiionyou:choose . .for'eacli set ofpatii.' ,.::' 

-~-- ..., ... \l{!f'1Sc.! r• .,r~r~· .. ·~ ... ,u .. (. 
;tm~~~(.~i f.l~rr~~ 
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Intellisync 

When data is transferred between fields in your communicator 
and your PC application, data is truncated in the target field if 
the source data is too lengthy to be accommodated. 

If you later edit the truncated data, the corresponding data in 
your other system is truncated after the next synchronisation. 
(Because Intellisync applies the detected ed it to the data.) 

If you want to edit truncated data, there is a workaround- as 
follows: 

Any time you edit truncated data, go in and edit the 
corresponding record in the other system. (It can be the same 
change you made in the shortened record, or a trivial edit of no 
consequence. The important thing is that a change is registered 
in that record). Make sure the "Notify" Conflict Resolution 
setting is selected. Then, during the next synchronisation, when 
the Conflict Resolution dialogue box is displayed for that record, 
select Ignore. This prevents the truncated data from overwriting 
the data in your other system. . 

Note: If you select lgnore;as recommended, you wiU be·: : ·' 
p~ompte~ft~ resolve t~e c:<>.~flict again ~e.~ext time you~ a 
synclironisation. If this' is not acceptable; you can highlight ·the 
ori"glnitl (nt>ri~truncatect) text 'in:the' Coilfli~t. Resoiutiqn .dialogue ·. 
and chbose Update. Noie~ however, that this will overWrite'the 
edit tharbaused theconfli~t in thefrrst'place:' ' · 
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Refer to "The 
Confirmation Tab" 
under "lntellisync 
Advanced Settings 
Dialogues• for 
information on the 
confirmation prompt. 
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If, for some reason, the data in either your communicator or your 
PC application is lost or unintentionally altered, do·not 
synchronise the data. Doing so will transfer the problem to your 
other system. · · 

For example, if all address records were accidentally deleted 
· from your PC application, Intellisync would see that all the 
records were deleted since the last synchronisation and remove 
the address records from your communicator. 

Fortunately, the confirmation prompt would warn you before 
such a synchronisation actually took place. In addition to 
warning you: it would allow you to use the Re-Sync button to 
execute a Full Re-Synchronisation. · 

Unlike a normal synchronisation, a full re-synchronisation 
would not delete the records in your communicator. This is 
because a full re-synchronisation is, in effect, a "first-run" 
synchronisation. That is, the history file is thrown out, and the 
synchronisation simply merges the contents of the two systems. 

Notes:.- _·: .. ·: ... :-... ·:' ·. : · ~ :·. · , := ··: '" '<' :: .=.: :. . .. 
. ~ .; =.':If llie .. d~ia· i·~··yo~ ~~~~lciit~r· or ·pc··~~~iic~ti"o~ ii~ot :.\; 
.·.·. -~·.:, J.ps(but,bas in. si)rh~ ·o!her \vay. bien pbriuptcd, you ·ca~. :_;:: ~ 
'. ·.:: q~le!e:t4~ .. con~eilfs of t!i.~dile : n.nd execute ·a ful(re:~·· .~ :: ,._ ··:: ... _:·.~·· . 
. ·. . sjnchronisation: to transfedhe. contents of the Qttier sjstem ' ... 
: ·:·.: )n~o 'the :~mptY)iit: ?(~ppl!ca~ioA. Note~: howe~ei: .:· tharo~Iy · .. :· 
:=>~· mapped values cari be transferred to·tlie empty- 5ysteffi:: .· :· ." , 
, ·: ·-~~apped v~Iues·*m i>~ los~ from any i~ord_s· i9u~d~I~te·:.··., 
• ' . .-The ,~~~irlnaii~~ ~rompi .. is':th~'-9itii·w~i-io=~~ciss.the .'Rt .. ·· 
. · .:: .Sync "i:mttori: It· is therefore advisabl~·io.l<~ ·acii~e the ::·.= .. ,::: 
··· '· co~fir~ -~eco~d ... Dei!!ii~ns ·;;~w.~!dn tlie)\dv~ced ·· ·. '·:. _-, 
~ · -Settings.dialogtie .. ::. ·. ·,,.:. -~· . ··.="< ·; .: -~~ _.:·, .. ·, _.-~·.:: . · 

, . . · 
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This dialogue 
appears only when 
Notify me when 
conflicts occur is 
the selected Conflict 
Resolution setting. If 
any other setting is 
selected, a change 
will always override a 
delete-that is, the 
changed record will 
be added to the 
system from which 
the record was 
deleted. 

Intellisync 

If, during a synchronisation, Intellisync discovers that a 
previously synchronised record has been changed in one system 
and deleted in the other since the last synchronisation, a special 
dialogue is displayed. 

Same llecord Changt!d and Deleted f3 

The Same Record Changed and Deleted dialogue alerts you to 
the deletion of the record in one system, and shows you the 
record as it has been changed in the other. A Jist of options 
allows you to decide between the following actions: 

+ Add: Adds the item back into the system from which it was 
deleted. 

· + Delete: Deletes the reco:'.d from the other system . .. 
+ Ignore: Lets each syste.;, remain as it is. 
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The Sync Log file can be 
a good source of 
information if you call for 
technical assistance. 

The Sync Log file is a 
simple text file that can 
be viewed using any 
editor. 

Each time you run a 
synchronisation, the file 
is overwritten. If you 
want to save a particular 
Sync Log file, rename 
the file before running 
another synchronisation. 
The file is located in a 
sub-directory (of the 
installation directory) 
named after the 
communicator serial 
number. 
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A set of buttons also appear at the bottom of the dialogue. 

• 0~: Exits the dialogue and applies the selected action. 

• Stop: Stops the synchronisation. 

• View: Lets you see the complete value of the highlighted 
field when it is too long to be displayed in the grid. 

• Help: CaJls on-line Help. 

Intellisync maintains a Sync Log file that is updated after each 
data transfer. The Sync Log file contains a detailed accounting of 
what occurred during the synchronisation, import, or export. 

Normally, it 's not necessary to read the Sync Log file after an 
operation. However, if errors were reported, it may be a useful 
source of information. 

To view the Sync Log file for the last data transfer, select the 
Sync Log command on the lntellisync View menu. 

The file identifies the records that were transferred from one 
system to the other, and indicates the exact action that was taken 
for each record. Field Mapping is also shown in the Sync Log file. 

Reading a Sync Log File 

Before any actions are taken during a data transfer, records from 
each system are read (looked at). You will see the term READ 
used in the Jog file to indicate this process. 
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Intellisync 

After reading records in each of the systems, lntellisync compares 
the records in both systems, as indicated in a section labelled 
Summary of Data Analysis. Here you will see phrases such as: 
Unchanged on Both Systems, Changed on First System, and 
Deleted from Second System. 

The next section of the Sync Log file lists the actions that were 
taken in your "First System" (Nokia 9110 Communicator) and 
"Second System" .cPC application) during the data transfer. 

Actions that may be noted in the Sync Log file are as follows: 

ADD: The record was added. 

DELETE: The record was deleted. 

FAll- RANGE: The item was excluded from the operation. It 
either failed the Date Range check for Appointments or it was a 
"completed" To-do list item, and the Transfer Only Pending 
Items option was checked in the To-do list tab of the Advanced 
Settings dialogue. 

IGNORE: The record was ignored. 

SKIP: The record was skipped because the data transferred was 
of a different type. 

UPDATE: The record was updated with a value or values from 
the other system. 
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lntellisync lets you 
configure and save both 
a local and a remote 
synchronisation for each 
Nokia 9110 
Communicator you 
connect and • register." 
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Intellisync allows you to configure and run "Remote" as well as 
"Local" synchronisations of Calendar data. A remote 
synchronisation is a synchronisation that you can run remotely, 
over a data call. 

To configure a remote synchronisation, follow the "Quick Start" 
instructions provided at the beginning of this chapter-only click 
the Remote tab to configure the operation. 

Remote vs. Local Synchronisation 
When you run a synchronisation locally. you are sometimes 
prompted for information. For example, if the "Notify" Conflict 
Resolution setting is selected, you may be prompted to resolve 
data conflicts. If your PC application requires a password, you 
will be prompted to enter a password-and so forth. 
Since interaction with your computer is not possible when you run 
a remote synchronisation, remote synchronisations are a little 
different from local ones. 
Please note: 

+ When you configure a remote synchronisation, you will notice 
that the Conflict Resolution tab of the Advanced Settings 
dialogue does not contain the Ignore and Notify options. 
(Add is the default Conflict Resolution setting.) 

+ · During a synchronisation, if Intellisync discovers that the 
same record has been deleted in one system and changed in 
the other since the last synchronisation, the change is applied 
instead of the delete. 

+ There is no Confirmation tab in the Advanced Settings 
dialogue because a confirmation prompt docs not display 
during remote synchronisations. 

+ You cannot synchronise PC applications that require you to 
type a password for access during a synchronisation. 
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Refer to Chapter 9, 
"Internet," in your Nokia 
9110 Communicator 
manual for information 
on connecting you·r 
communicator to your 
PC via the Internet. 

Intellisync 

Running a Remote Synchronisation 

In order to run a remote synchronisation, you must have an 
Internet access point to facilitate the remote connection to your 
PC. In addition, PC Suite for Nokia 9110 Communicator must 
be up and running on your PC. · 

Once you have configured a remote synchronisation, follow 
these steps to run it from your communicator: 

I. Press the System application button on your communicator. 

2. Choose Remote Synchronisation and press Select. 

3. Press Settings and define the destination host (the IP 
address of the server PC) and select your Internet access 
point. 

4. Press Start to start a data call and begin synchronising. 

When the synchronisation is complete; the data call ends. 
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lntellisync Glossary 

Boldfaced text identifies 
additional terms defined 
in this section. 

See "The Conflict 
Resolution Tab" under 
"lntellisync Advanced 
Settings Dialogues· for 

more information about 
Conflict Resolution and 
data conflicts. 
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Read this section to gain an understanding of some of the terms 
that are used to describe PC Suite's lntellisync function. 

A process (controlled by a setting in the Conflict Resolution tab 
of the Advanced Settings dialogue) that is sometimes used by 
Intellisync to detcnnine how to. resolve data conflicts during 
synchronisations. See Data Conflict, below. 

A data conflict occurs when records in both systems have 
matching key field values but conflicting data in other mapped 
fields . (For example, if both systems have address records in 
which the First and Last Name values are identical, but the 
address values differ.) 

Th~ very first time a set of data is synchronised (and any time you 
import or export data) the Conflict Resolution setting in the 
Advanced Settings dialogue is used to resolve an such conflicts. 
Upon subsequent synchronisations of the same data (after the 
history me has been created), the Conflict Resolution setting is 
needed only under either of the following two conditions: 

I) When records with the same key fields have been added to 
both systems since the last synchronisation, but they have 
conflicts in other mapped fields. 

2) When mapped fields in previously synchronised records (with 
matching key fields) have been edited since the last 
synchronisation, but edited differently. 
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The conversion of a repeating item into many individual items 
("fanned" items) having unique dates. Fanning occurs when one 
of your systems does not support an incoming repeating item. 

The linkage that directs the comparison and transfer of data during 
an Intellisync data transfer. Field mapping is contained (and can 
be edited) in the Intellisync Field Mapping dialogue. 

To access the Field Mapping dialogue, select the Field Mapping 
button in the Advanced Settings dialogue. 

A statement that can be applied to a synchronisation to restrict 
the records that are included in an operation. See "The Filters 
Tab" under "Advanced Settings Dialogue" for information about 
using Intellisync filters. 

The first synchronisation of a ~.articular set of data. 

A first-run synchronisation is different from.subsequent 
synchronisations of the same set of data because no history file 
exists. The history file is created during the first run (and the 
Conflict Resolution setting is used to settle data conflicts 
between the two systems.) 

., 
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A special m<?de of synchronisation that merges rather than 
synchronises data in your two systems. (In effect, a "first-run" 
synchronisation.) This is used for restoring lost data and for 
maintaining data integrity when records have been altered. A full 
re-synchronisation can be performed using theRe-Sync button in 
the confirmation prompt that may appear before the results of a 
synchronisation are applied. Refer to "The Confirmation Tab" 
under "Intellisync Advanced Settings Dialogues" for more 
information. · 

A file that is created by a ''first-run" synchronisation and 
updated after every subsequent synchronisation. This file aids 
Intellisync in determining which data to use when there are 
discrepancies between your communicator and PC application. 
See "Synchronisation and History Files" under "Intellisync 
Special Topics" for more complete information. 

A field specially defined to detect data conflicts during a data 
transfer. During a synchronisation, Intellisync compares the 
values of mapped fi(\lds,in your two systems. When "key" values 
match, but other mapped values differ, a data conflict exists. For 
example, in Contacts records, if Name (key) values match, but 
Phone values differ, this is a data conflict. 

Fields that are linked for data transfer in the.Intellisync Field 
Mapping dialogue. 

~~- -------
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A type, or category, of data contained in a PC application. For 
example, Addresses, Notepad, and Schedule are sections 
contained in some of the PC applications supported by Intellisync. 

The Intellisync operation that compares the records in your 
communicator to the records in a PC application file, and makes 
whatever changes are necessary in either system to make sure that 
they both contain the same data. 

A component of the Intellisync software that enables Intellisync 
to transfer data between your Nokia 9110 Communicator and a 
particular PC application. 
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lntellisync Menu Commands 

... -4·- t£ ~E.n.d.tlt..eH·• ' . . ~W.!~ :·'"7~.:· t-~~·i· ~ 

Status Bar Toggles stat11s bar on and off. 

Sync Log Displays the Sync Log for the last 
/nte/lisync operation. 

·~oMP,oN'ENts'f~t~t :t 
Contacts Starts Contacts application component. 

Intellisync Accesses Inte/lisync component. 

File Transfer Accesses File Transfer component. 

Backup/Restore Accesses Backup/Restore component. 

Install/Remove Accesses Install/Remove component. 

Import/Export Accesses Import/Export component. 

pme..,·~--1~~~-,. 

Contacts Displays Contacts Address Fomzat and 
File options. 

Desk Stand Button Displays desk stand button options. 
Settings 

Registered Lists the commzmicators that have been 
Communicators connected and named. 

Preferences Displays the Preferences dialogzJe. 
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IHELP;I~ ,·t'n:·~:}:~,! 

Contents Displays Oll·line Help Contents. 

Commands Displays command infomration. 

UsinRHelp Accesses Help f_nr nn-line Help. 

Premier Upgrade Displays /ntellisync registration and 
Premier Upgrade subscription 
information 

About PC Suite Displays "About PC Suite " dialo~ue. 
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File Transfer Functions 

Chapter 4 : File Transfer Functions 

The PC Suite File Transfer functions let you 
move, copy, paste, rename, and delete Nokia 
9110 Communicator and PC files and folders in a 
familiar Windows Explorer-type environment. 

Topics in this chapter include: 

+ Using the File Transfer Functions . 

+ File Transfer Window Panes 

• Selectirw Files 

• Copying Files and Folders 

+ Moving Files and Folders 

+ Deleting Files an~ Folders 

+ Renaming Files and Folders 

+ File Properties 

+ File Transfer Menu Commands 

Page 85 

Page 00471



PC Suite for Nokia 9110 Communicator 

Using the File Transfer Functions 

Unlike Windows Explorer, 
you cannot launch a 
program or open a file 
from the File Transfer 
screen. 
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The PC Suite File Transfer functions let you move, copy, paste, 
rename, and delete Nokia 9110 Communicator and PC files and 
folders in a familiar Windows Explorer-type environment 

Note: Built-iri' cony~rsion uiiliiies for sorrie._types of files allow ' 
you' to iransfe'r -~ifl'oompatible;; flles.betweeri'your comnmhi.ca'tor 
and your PC in'a re-adable form .. Fii'es that are~onverted in~lude: 
Nokia 9.110 Communicator Notes files, communicator Fax files, 
.and PC.TIFF files (compressed in Group 3 :(ld)Fax 'fonl:uit)._:'· · 

Follow these steps to access the PC Suite File Transfer functions. 

l. Start PC Suite and click the File Transfer icon in the 
opening screen. 

2. Connect your communicator to your PC COM port or 
establish an infrared connection. If you are prompted to do 
so, enter a name for your communicator. 

;M Qi@§Mitffl§iiiiii I I I p @CfjfflMI ..:iofxl 
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Shift-click or Ctrl ­
click also selects 
multiple files or 
folders. 

If press the Ct.rl key 
while you drag the 
item, the item is 
removed from its 
original location. 

File Transfer Functions 

~ ,....~.- · --~ f'T"W"' ~·- - """'''='1$""...,..""' ~ .... ,!'T:"!""' ~·ru 

· iFi .l~tT.r~tJ.Sf.~r WJ~~~c;>V\t.R~n.~§ ~~~tt~:~ 
The File Transfer screen looks very similar to Windows Explorer. 
It is divided into two panes that can be re-sized by dragging the 
splitter bar that separates them. 

Drives and folders for both the Nokia 91 10 Communicator and 
your PC are listed on the left, and can be expanded by clicking the 
+ icon. The contents of the drive ·or folder highlighted on the left 
are shown on the right side of the window. 

Standard Windows file selection methods are used to select files 
or folders in the File Transfer screen. You can select an item by 
clicking on it with your mouse, or using the up and down arrow 
keys on your keyboard. 

Use the Shift key in combination with the up and down arrow 
keys. to select multiple adjacent items. 

Files and folde~ can be copied in the File Transfer window 
using "drag and drop" or by copying and pasting. 

To Drag alld Drop: 
1. In the left pane, highlight the drive or folder containing the 

item you want to copy. 

2. In either pane, select the item(s) you want to copy. 

3. Hold the left mouse button down, and drag the item(s) to the 
new location. A+ next to·ibe cursor shows that you're 
copying (and not cutting) the item. 

4. Release the mouse button. 
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Keyboard Shortcuts: 

Ctri-C =Copy 

Ctri-V = Paste 

Note that the use of the 
Ctrl key in drag and drop 
operations is not 
identical to its use in 
Microsoft Explorer. · 

You cannot cut read-only 
files or root folders from 
the communicator. 
CuUPaste operations for 
these files/folders are, in 
effect, Copy/Paste 
operations. 

Keyboard Shortcuts: 

Ctri-X =Cut 

Ctri-V = Paste 
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To Copy and Paste: 
1. In the left pane, highlight the drive or foider containing the 

item you want to copy. 

. 2. In either pane, select the item(s) you want to copy. 

3. Select Copy from the Edit menu, or click the right-mouse 
button choose Copy from the pop-up menu. 

4. Highlight the left-pane drive or folder to which you want to 
copy the file. 

5. Select Paste from the Edit menu, or click the right-mouse 
button and choose Paste from the pop-up menu. 

rNisvin+~t~iie~taWCfffil:iiHers1':. """-r-......_·~11;~«.~.~ ..... 9 ... G·.;.l~·~.:"''~u: •. ;.;~..,-.:..u..-..-,...~\t4"'•..,4-'ti .. .,..._.!!...,..OW!tt.~~.~" 
Files and folders can be moved in the File Transfer window 
using "drag and drop" or by cutting and pasting. 

To Drag and Drop: 
Use same drag and drop technique described previously for 
copying. However, you must press the CtrJ_k~y while dragging. 
If you do not, the file or folder \vill not be removed from its 
original location. 

To Cut and Paste: 
1. In the left pane, highlight the drive or folder containing the 

item you want to cut. 

2. In either pane, select the item (or items) you want to cut 

3. Select Cut from the Edit menu, or click the right-mouse 
button choose Cut from the pop-up menu. 

4. Highlight the left-pane drive or folder to which you want to 
move the file or folder. 

5. Select Paste from the Edit menu, or click the right-mouse 
button and choose Paste. from the pop-up menu. 
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Multiple items 
can be deleted at 
once in the right 
pane. Only one 
item at a time 
can be deleted 
from the left 
pane. 

File Transfer Functions 

M'"'""~""1-J<!"T':-m"' -.-•# Jl-t•~·•·t~·...,.. . ..,..,....,....,. • ..,..,,.,. "''""l,.._ """"C!':~' 
lo· 'l···t·········F\·1·' ' . ._,, ... 'd'Ft··. ,·;:.._ ..... ,- ····.r~r$·'1•n:.~_ ~· .. ,,~., ··~ : e e tng·• I es=.an -~ 0 uerS,ii;'trf.i!fX':itS'-i 
,,.,, .... ,, .,. ... t • .,~ .. l•'• t. [ • .... ~.~t.l"u••H' ), ••·•• ·•·•1- •.• ~ .. ,.,.,....,..l.~ ••u•,.O,.'h.1·,.t ~- '"'"'-' : 

There are three ways to delete an item from the left or right pane 
. of the File Transfer window: 

Select t~e item you want to delete. Then: 

• Press the Del key 

• Select Delete from the File menu, or 

+ Press the right mouse button and choose Delete from the 
pop-up menu. 

· Note: You cannot delete root folders or read-only files from the 
communicator. 

Items deleted from your PC are sent to the Windows Recycle 
bin. 

· 1Rein'""~a~{:~1w~~r.F"'"'"i11!5 :'an~1~&Jcle·fs1 ;,~im~i-1' l! .............. .... •.z.•. Y :~;::--~ ... ~~- ..... ~ ...... .. ·- J .... ~x""T'::= t: -

Just like in Windows Explorer, you can rename files and folders 
using the Rename command. 

To rename a file or folder: 

1. Select the file or folder you want to rename in either pane. 

2. Select Rename from the File menu, or click the right-mouse 
button and choose Rename from the pop-up menu. 

3. _Type a new name and then press Enter. 

Note: You cannot rename non-empty folders, root folders, or 
read-only files in the communicator. 
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PC Suite for Nokia 9110 Communicator 

When a Properties 
dialogue is displayed 
for a communicator 
file or folder, check 
boxes are disabled 
(greyed). You cannot 
change the attributes 
of a file or folder in 
the communicator. 
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Like Windows Explorer, the PC Suite File Transfer function lets 
you display and edit a file or folder's "properties." 

Follow these steps: 

I. Select a file or folder in either pane. · 

2. Select Properties from the File menu, or click the right­
mouse button and choose Properties from the pop-up menu. 
This displays the Properties dialogue. 

Check or un-check the check boxes in this dialogue to change a 
PC file or folder's attributes. 

+ Click OK to save changes and exit the dialogue. 

• Click Cancel to exit without saving c\J.anges. 
'.-!1 

+ Click Apply to save changes without exiting. 
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File Transfer Functions 

File Transfer Menu· Commands 

Exit · I Exits PC S11ile. 

VIE\V'":-~:;:;i .;-: ,I 

Status Bar Toggles status bar on and off. 

Large Icons Switches view to Large Icons mode. 

Small Icons Switches view to Small/con mode. 

List Switches view to List mode. 

Details Switches view to Details mode. 

Arrange Icons Lets you arrange icons by Name, Type, 
Size, or Date. 

Refresh Reji-eshes (updates) display. 

ErNr11!P::t-.~ ' -, 
\7".- 1'1"-.. 

Cut C11ts the selected file or f()lder. 

Copy Copies .. the selected file or folder. 

Paste Pastes the item that was cut or copied 
to the selected location. 

Select All Selects all the items in the open/older. 

Invert Selection Inverts the selection status of each file 
in the open _folder. 
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PC Suite for Nokia 9110 Communicator 

·. "6 •· ~ r:r·~·J C fo.4P.O . TS '·":.::•. 

Contacts Starts Contacts application component. 

Intellisync Accesses lmellisync compo11e111. 

File Transfer Accesses File Transfer compo11ent. 

RackupfRestorc Accesses Backup/Rest ora component. 

Install/Remove Accesses Install/Remove component. 

Import/Export Accesses Import/Export component. 

Commands 

Usin Hel 

About PC Suite e. 
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Backup and Restore 

Chapters·: Backup and Restore 

This chapter discusses the PC Suite Backup and 
Restore commands, which safeguard the data in 
your communicator. 

Topics include: 

• Backing Up Your Data 

• Restoring a Backup 

• Backup/Restore Menu Commands 
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PC Suite for Nokia 9110 Communicator 

Backing Up Your Data 

To-do list records are 
included when you 
backup the Calendar 
application. 

When you configure a 
Backup operation, your 
configuration is saved 
when you run the 
Backup or exit the 
Backup tab. 
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Follow these steps to backup some or all of the data on your 
Nokia 9110 Communicator: 

1. Click the Backup/Restore icon in the PC Suite opening 
screen. 

2. Connect your communicator to your PC COM port or 
establish an infrared cOnnection. 

If prompted to do so, enter a name for your communicator. 
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